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1. Before You Begin 
Welcome to the FAA eForm Service Help system. This system will guide you through the different aspects 
of using the electronic forms. It will walk you through Form Manager, provide answers to general questions, 
cover system access, and much more. 

If you have any problems, please feel free to contact the AVS National Service Desk (NSD) 24 hours/7days 
a week. 

Phone: 1-877-AVS-NSD1 (1-877-287-6731) 

Email: AVS National Service Desk 

 

2. System Requirements 
The following operating system has been tested and certified to work with the eForm Service and 
subsequent forms. Therefore, we can provide user support only for this environment. 

 
Windows Platforms (Supported by Aviation Safety) 

 Adobe Reader v9.3.1 (or later) or Adobe Reader v9.1.1 (or later) 

 Adobe Flash Player v10.0.22.87 (or later) 

 Intel 1.3 GHz processor  

 Microsoft Windows XP Professional or Home Edition, or Tablet PC with Service Pack 2; 
Windows 2000 with Service Pack 4, Windows Server 2003 

 128MB of RAM (256MB or higher recommended)  

 335MB of available hard disk space 

 Microsoft Internet Explorer 8.0 

 

IMPORTANT NOTE:  The system has been tested to work with Acrobat version 7.1.3 (or later). If 
both Reader and Acrobat are installed on the same computer, it is recommended for best 
performance that both are the same version.   

 
Although Adobe Corporation advertises that their Reader product works on other operating systems 
(see list below), Aviation Safety does not have the resources to support these multiple platforms. 

 
Windows Platforms (Not supported by Aviation Safety) 

 Microsoft Vista 

 Microsoft Windows 7 

 Firefox v2 or v3 

 Google Chrome 

 Apple Safari 

 

http://eformservice.faa.gov/Email.aspx
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Macintosh  

 Adobe Reader v9.1.1 

 Adobe Flash Player v10.0.22.87 (or later) 

 PowerPC G4, G5, or Intel processor  

 Mac OS X v10.4.11 to 10.5.6  

 128MB of RAM (256MB or higher recommended)  

 405MB of available hard disk space  

 Safari 2.0.4 (or later)  

 
 

Linux  

 Adobe Reader v9.1.1 

 Adobe Flash Player v10.0.22.87 (or later) 

 32-bit Intel Pentium processor or equivalent 

 Red Hat Linux WS 5, SUSE Linux Enterprise Desktop (SLED) 10 SP2 and Ubuntu 7.10  

 GNOME or KDE Desktop Environment 

 512MB of RAM (1GB recommended) 

 150MB of available hard-disk space (additional 75MB required for all supported font packs)  

 GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later)  

 Firefox 2.0 (or later) 

 OpenLDAP and CUPS libraries 

 
 

Solaris  

 Adobe Reader v9.1.1 

 Adobe Flash Player v10.0.22.87 (or later) 

 32-bit Intel Pentium processor or equivalent 

 Solaris 10 u5 or OpenSolaris 2008.11  

 GNOME or KDE Desktop Environment (GNOME only for Solaris 10) 

 512MB or higher of available RAM (1GB recommended) 

 200MB of available hard-disk space (additional 75MB required for all supported font packs) 

 GNU C library (glibc) version 2.3 (or later) 

 GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later) (On Solaris10, also works with 
GTK 2.4.9 also) 

 Firefox 2.0 (or later) 

 Open LDAP and CUPS libraries 
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3. Block or Allow Web Site Trusts 
To manually allow web sites or change a web site from 'blocked' to 'allowed', follow the instructions below.  

 
Manually Allow Web Sites 

1. Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader and select 
Run if asked to run the file. 

2. Click Edit > Preferences on the menu bar at the top of the screen. 

3. Select Trust Manager in the Categories list. 

4. Click the Change Site Settings button under the Resource Access section. 

5. Type the web address in the text box. 

6. Click the Allow button. 

7. Click the OK button to save and close the Preferences. 
  

IMPORTANT:  To use the eForm Service where data searches are involved, it is required to always 
allow the eformservice.faa.gov web site trust. 

 
 

Change Blocked Web Sites to Allowed 

1. Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader and select 
Run if asked to run the file. 

2. Click Edit > Preferences on the menu bar at the top of the screen. 

3. Select Trust Manager in the Categories list. 

4. Click the Change Site Settings button under the Resource Access section. 

5. Highlight the web site in the Site listing that you want to unblock. 

6. Click the Remove button. 

7. To allow the web site:  

 The next time you access the web site it will ask you to Allow or Block the web site you are 
entering. Click the Allow button. The web site will add itself to the Allow list in Adobe. 

 If you want to manually add the web site instead of waiting till the next time you visit the 
web site, follow the above set of instructions on how to manually allow web sites.  

8. Click the OK button to save and close the Preferences. 
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4. Turn Off/On Adobe Auto Complete 
 

Turn On Adobe Auto Complete 

1. Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader. 

2. Click Edit > Preferences on the menu bar at the top of the screen. 

3. Select Forms in the Categories list. 

4. Near bottom of the screen, under Auto-Complete, click on the drop down box and change the 
settings from 'Off to 'Basic'. 

5. Click the OK button to save and close the Preferences. 

 

 
 

Turn Off Adobe Auto Complete 

1. Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader. 

2. Click Edit > Preferences on the menu bar at the top of the screen. 

3. Select Forms in the Categories list. 

4. Near bottom of the screen, under Auto-Complete, click on the drop-down box and change the 
settings from 'Basic' to 'Off'. 

5. Click the OK button to save and close the Preferences. 
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5. FAA Form 337 

5.1 Before You Begin 
Welcome to FAA Form 337 Help System.  The following Help Topics are provided for those who are going 
to perform or supervise a major repair or a major alteration and are going to fill out the FAA Form 337.  

If you have any problems, please feel free to contact the AVS National Service Desk (NSD) 24 hours/7days 
a week. 

Phone:  1-877-AVS-NSD1 (1-877-287-6731) 

Email:  AVS National Service Desk 

 

5.1.1 Download Adobe Reader 
IMPORTANT NOTE:  The FAA eForm Service has been tested to work optimally with Adobe 
Reader and Acrobat Professional v9.1.1 (or later). Additionally, the program requires Adobe Flash 
Player v10.0.22.87 (or later). 

 

How to check which version is currently installed   

1. Open Adobe Reader. 

2. Select Help from the Menu Bar and click About Adobe Reader. 

3. Note the version displayed on the upper right area of the splash screen. 

4. If it doesn’t meet the minimum System Requirements for the eForm system, proceed with the 
uninstall process below. 

 
 

NOTE: To uninstall or install Adobe Reader, you need to have administrative rights to your 
computer. If you do not have administrative rights, contact your local computer support staff to 
remove Adobe Reader and install the supported version.  

 

Adobe Reader Uninstall Instructions 

1. Close all open applications and programs. 

2. Click the Start Button and select the Settings menu item (if available). 

3. Click on Control Panel.  

4. Click on Add or Remove Programs. 

5. Once the Programs list appears, do the following: 

a. Scroll through the list and select the older, unsupported version. 

b. Click the Remove button at the right. 

c. Click Yes. 

d. Follow the onscreen removal instructions. 

e. When prompted, reboot the computer.  

6. Once rebooted, install the supported version using the following instructions. 

http://eformservice.faa.gov/Email.aspx
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Adobe Reader Install Instructions 

 

1. To install, click the Adobe Reader icon below. This will bring up the File Download screen.  
 

 
  

2. Click on the Run button. After the Optimizer runs, the Setup screen will appear. 

3. Click Next. 

4. Click Next again at the Welcome and Destination screens. 

5. At the Ready to Install screen, click Install. 

6. At the Setup Completed screen, click on Finish. 

7. Once installed, double-click the Adobe Reader icon on your desktop. 

8. Click the Accept button on the license agreement screen, and then Close. 

9. If a message appears asking if you want automatic updates, select No.  

10. Adobe Reader is now ready to be used with eForm Service.  

 
 
 
 
 

http://eformservice.faa.gov/downloads/AdbeRdr811_en_US.exe�
http://eformservice.faa.gov/downloads/AdbeRdr811_en_US.exe
http://eformservice.faa.gov/downloads/AdbeRdr811_en_US.exe
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5.1.2 Requesting a Digital Certificate 
A Digital Certificate is a signing certificate issued by a Certificate Authority for the purpose of 
digitally signing PDF documents. To access the eForm 337 system, both internal and external users 
will need to get a digital certificate from Team Askin Technologies, Inc. (TATI). For detailed 
instructions and support, visit the Team Askin site by clicking a link on this eForm web page. This is 
a third party site and not managed by the FAA. 

IMPORTANT:  When requesting digital certificates, submit the name that is used for legally signing 
documents (e.g., James O. Goodrich vs. Jim Goodrich). 

5.1.2.1 Internal (FAA) Form 337 Users 

 FAA Personnel (inspectors) who are authorized to perform field approvals 
should call or email the AVS National Service Desk and request a Digital 
Certificate.  

 ASIs will be provided digital certificates via an email invitation from Team Askin. 
The only action necessary is to click the link provided and follow the 
instructions and prompts. Detailed instructions are available from the Team 
Askin web site. 

 Digital signatures provided by the FAA are for official use only. An employee 
who wishes to use the system as an external user (for personal use) must 
obtain an additional digital signature at this/her own expense. 

5.1.2.2 External (Industry) Form 337 Users 

The following instructions provide steps for Non-FAA Personnel to request a digital 
certificate. 

1. Access the https://eformservice.faa.gov/eform337.aspx web site. 

2. Click the link in the left navigation menu to request a digital certificate. 
 

 

http://eformservice.faa.gov/ReDir.aspx?u=askin
https://eformservice.faa.gov/eform337.aspx
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3. An Exit Warning page will appear as shown below. Click Continue to proceed. 

 

 
  

 You will go through an Identity Authentication process where you will be required to enter personal 
information such as Social Security Number, Date of Birth, home address, and phone number. 
  

 You will then be directed to the GeoTrust web site to answer questions based on the information 
you provided. 
  

 The standard fee for Authentication and a Digital Certificate is $30.50. Before you begin the 
purchase, be prepared with your personal financial information.  You are allowed two (2) attempts to 
complete your authentication.  If you cancel or timeout during the authentication process, you will 
charged the authentication fee. The annual renewal cost for Industry users is $29.50.   

 
 You will receive an email invitation.  Simply follow the instructions provided in that email and the 

prompts provided by Team Askin.  
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5.1.3 Installing Digital Certificate 
 

IMPORTANT NOTE:  After receiving the .p12 or .pfx file, save a copy of the file to a safe, secure 
location as a backup file for future needs.  Never import the signature from this file/location.  In case 
you forget your password or a problem occurs with the file, you can copy the backup .p12 or .pfx file 
to another location and import it again. 

5.1.3.1 Prepare Adobe Reader (and Acrobat Professional if 
installed)  

1. Open Adobe Reader (do the same for Adobe Professional). 

NOTE:  For optimal use, it's highly recommended that both Adobe Reader and Adobe 
Acrobat Professional are the same version. 

2. From the top menu, click Edit – Preferences. 

3. In the Preferences window, click the Security category on the left. Make sure that the 
check box for ‘Verify signatures when the document is opened’ is selected. 

4. Click Advanced Preferences button. 
 

 
  

5. Click the Windows Integration tab. 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
10 

6. Select all check boxes. 
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7. Click the Verification tab and select the options shown in the window below. 

 

 
 

8. Click OK again to close the Advanced Preferences window. 

9. Click OK to close the Preferences window. 

10. In Adobe Reader:  Click Document – Security Settings from the top main menu. In 
Adobe Acrobat:  Click Advanced – Security Settings. 

11. In the Security Settings window, select Time Stamp Servers from the options on the 
left and click the New icon on the menu bar. 
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12. Enter the following information in the ‘New Time Stamp Server’ window.  

a. Enter ‘Verisign Server” for the Name. 

b. Enter “http://timestamp.verisign.com/scripts/timestamp.dll” for the Server URL. 

c. DO NOT select the ‘This server requires me to log on’ check box. 

 
 

13. Click OK and close the Stamp Server window.  
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14. Ensure that the new server name and URL are listed correctly. Exit the Security 
Settings window by clicking the X at the top right hand side of the window.  

 
 

15. Exit the Adobe application. Your digital certificate is now ready for use. 
  

5.1.3.2 Importing the digital certificate 
  

1. Double-click your .p12 or .pfx digital certificate file. 

2. Click Next. 
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3. Note the path to the digital certificate file already is entered in the File Name: Field. 

4. Click Next. 

 

 
  

5. Enter your password and select both check boxes. 

6. Click Next. 
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7. Keep default selection and click Next. 

 

 
 

8. Click Finish. 
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9. Click Set Security Level. 
  

 
 
  

10. Select High and Click Next. 
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11. Enter and confirm your password (use the same password used to download the Digital 
Certificate) and click Finish. 

 
  

12. Click OK. 

13. Click OK when prompted that the import was successful. 
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5.1.3.3 Viewing a correctly installed digital certificate from a Trusted 
Certificate Authority 
  

1. Open Internet Explorer and click Tools - Internet Options - Content tab - Certificates 
button.  Select the certificate entry and click the View button to see the Certificate 
Information in the General tab: 

 

 
 
 

2. Click the Certification Path tab.  Properly imported certificate path should look like the 
dialog below for your specific certificate: 
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3. Click OK. 

4. In the Certificates window, select the Trusted Root Certification Authorities tab. 
Scroll down and locate the Equifax Secure eBusiness CA-1.  This is the trusted root 
used for the digital certificate. 
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5. Click Close, and then click OK. 
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5.1.4 Problems Accessing the System 

5.1.4.1 Accessing the System 

 

Visit http://eformservice.faa.gov/ 

 

Problems accessing the system? 

Airmen Certificate Not Found 

Airmen Certificate Revoked 

Digital Certificate Expired 

Digital Certificates 

 

5.1.4.2 Airmen Certificate Not Found 

 

Upon logging into the system you were notified your certification could not be found; contact 
your local FSDO to rectify the problem. 

 

5.1.4.3 Airmen Certificate Revoked 

 

Upon logging into the FAA Form 337 system you were notified your certification is expired; 
contact your local FSDO to rectify the problem. 

 

5.1.4.4 Digital Certificate Expired 

 

Upon signing a signature field in a form, users will receive an error message if their digital 
certificate has expired.  To acquire a new digital certificate, contact TeamAskin.com. This is 
a third party site and is not managed by the FAA. The link to that web site is found in 
http://eformservice.faa.gov/ReDir.aspx?u=askin.  

 

5.1.4.5 Digital Certificates 

 

Some forms require an Electronic Digital Signature to be used. This Digital Signature will be 
used the same as your actual signature, and will be just as binding. To obtain a digital 
signature, contact Team Askin for pricing information.  To purchase a digital signature, 
there will be a one time setup fee and a yearly maintenance fee. 

Digital Signatures are a way for you to sign each Workflow form securely without actually 
signing the form. 

http://eformservice.faa.gov/
http://eformservice.faa.gov/ReDir.aspx?u=askin
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To use your Digital Signature, click in the signature/date field in the Form 337 (where 
orange “Sign” graphic appears). The Sign Document dialog box appears as show in the 
example below.  Select your signature from the drop-down box, and then click Sign. 

 

 
 
 

5.1.4.6 Locked Account 

 

To unlock your account, contact AVS National Service Desk at 877-287-6731 or email AVS 
National Service Desk. 

http://dev.avr.faa.gov/eforms/Email.aspx
http://dev.avr.faa.gov/eforms/Email.aspx
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5.2 Working with the Form 

5.2.1 Form Field Information 
The system includes Data Integrity which requires the completion of certain fields or blocks within 
the form based on the steps within the Form 337 submission process.  Error Messages will appear 
if required fields are not completed. 

 
BLOCK 1 

Aircraft: 

 

Nationality and Registration Mark 

The user should enter nationality and registration mark as found on the current AC Form 8550-3. 

 

Serial No. 

Enter serial number as found on the aircraft manufacturer’s identification plate. 

 

Make 

Enter make as found on the aircraft manufacturer’s identification plate. 

   

Model 

Enter model as found on the aircraft manufacturer’s identification plate. 

   

Series 

Enter series as found on the aircraft manufacturer’s identification plate 

 

Note: When you enter the Registration Mark, the Make, Model, Name (Block 2), and Address 
(Block 2) will be entered automatically after pressing the Search button next to Registration 
Mark.   Manually enter the Serial No. as shown on the aircraft manufacturer’s identification plate 
(this is used as an additional validation check).  Verify that the information in block 1 and 2 
matches the aircraft manufacturer’s identification plate. 

 
BLOCK 2 

Owner: 

 

Name (As shown on registration certificate): 

Verify that the auto-filled name matches the aircraft owner’s complete name as shown on AC Form 
8050-3.  Correct if needed. 
  

Address (As shown on registration certificate): 

Verify that the auto-filled address matches the aircraft owner’s complete address as shown on AC 
Form 8050-3.  Correct if needed. 
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Note:  As the Initiator, complete blocks 4, 5, 6 and 8 (Blocks 1 and 2 are Optional for 
component alteration/repair). 

 
BLOCK 3 

For FAA Use Only: 

 

ASI sign-off (left side of form) 

From the drop-down box, select the sign-off statement appropriate to the type of data approval 
being granted.  Click on the Inspector Signature field and add your Digital Signature to the 
document. 
  

DAR 50 and DAR 51 sign-off (right side of form) 

From the drop-down box, select the sign-off statement if a DAR 50 or DAR 51 is certifying the data. 
Add your Authorization Number, click on the Designee Signature field, and add your Digital 
Signature to the document. 

 

BLOCK 4 

Type: 

 
Enter a checkmark in the appropriate column to indicate whether the unit was repaired or altered.  

 

Note: If you do not indicate whether the unit was repaired or altered, you will not be able to 
select a Make, Model, and Serial No. for the unit. 

 
BLOCK 5 

Unit Identification: 

 
Airframe 

No Make, Model, or Serial No. need to be entered. 
  

Power plant 

Select the correct Make from the drop down list and provide the Model and Serial No. for the unit 
being repaired or altered. 
  

Propeller 

Select the correct Make from the drop down list and provide the Model and Serial No. for the unit 
being repaired or altered. 
  

Appliance 

Enter the correct Make, Type, and Manufacturer, and provide the Model and Serial No. for the unit 
being repaired or altered. 
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BLOCK 6 

Conformity Statement: 

 
A.  Agency’s Name and Address 

“Enter name of the mechanic, repair station, or manufacturer accomplishing the repair or alteration. 
 Mechanics should enter their name and permanent mailing address.  Repair station and 
manufacturers should enter the name and address under which they do business." 
  

B.  Kind of Agency 

“Check the appropriate box, at the left of the agency name, to indicate the type of person or 
organization that performed the work." 
  

C.  Certificate Number 

“Mechanics should enter their mechanic’s certificate number.  Repair stations should enter their air 
agency certificate number and the rating(s) under which the work was performed.  Manufacturers 
should enter their type production number, STC number or TSO number of the appliance altered.” 

 
 

Fuel System Modification: 

Check this box if the modification includes extended range fuel tanks installed within the passenger 
compartment or baggage compartment.  Leave the check box blank if no extended range fuel tanks 
were installed. 

 

Compliance Statement: 

Signature of Authorized Individual 

Click inside the Signature box to apply your Digital Signature after repair or alteration is complete. 

 
 

BLOCK 7 

Approval for Return to Service 

 

Approval for Return to Service 

Approved/Rejected:  “Check the “Approved” or “Rejected” box to indicate the finding. 

 

By 

Check the appropriate box, to the left of the name, to indicate who made the finding. 

 

Other   

Use this block to indicate a finding by a person other than those listed. 
  

Certificate or Designation No. 

Enter the appropriate certificate or designation number. 
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Signature of Authorized Individual 

Click inside the Signature box to apply your Digital signature for the approval of Return to Service. 

 
BLOCK 8  

NOTE:  Describe repair or alteration in Block 8; this is a required field to submit the form to 
the next stage (i.e., ASI, DAR or Return to Service agent).  Cut and paste text as necessary – 
remembering the 8,000 character limitation.  Block 8 will expand dynamically based on text 
entered.  Pages will be created as you add text or new text blocks.  If necessary, type the 
phrase “See attached files” and attach a file that describes the work accomplished and 
select "Send to Registry”. 

 

Description of Work 

Enter a clear and concise statement describing the work accomplished.  It is important that the 
location of the repair or alteration relative to the aircraft or component be described.  The approved 
data used as the basis for approving the major repair or alteration for return to service should be 
identified and described in this area. 
  

Interim Inspection Comments  

Enter the interim inspection comments into the specified box. 

 

Signature of Authorized Individual 

Click inside the Signature box to apply the Digital signature for the ASI accomplishing the final 
review. 
  

Additional Sheets Needed 

Check the box at the bottom of the page if additional sheets are needed to describe the work 
accomplished. 
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5.2.2 Digital Signature Status Icons 
The Adobe Reader or Acrobat will display one of several digital signature icons.  The definitions 
below will help you recognize the difference between each of the digital signature icons. If desired, 
you can check the authenticity for a digital signature by first making sure you are connected to the 
Internet, so that Adobe Reader or Acrobat can check the digital signatures. Next, view the 
Signatures tab on the navigation pane (shown below); this shows all the signatures for the 
document. Then click “Validate All” on the Signatures tab to validate all the signatures in the 
document. 

NOTE:  Depending on the version of Adobe Acrobat or Reader you’re using in you web browser, 
the digital signature icons you see may differ from the examples show below. 

5.2.2.1 Definitions 

Adobe Reader or Acrobat displays one of several results for each entry in the Signatures 
tab. Typical results include:  
 

  Valid Signature:  A green check mark with a signed document indicates that the 
signer’s Digital ID is valid and current. 
 

  Invalid Signature:  A red X with a signed document indicates that the Digital ID 
that was used to apply the digital signature is not valid because it has expired or has been 
canceled/revoked. 
 

  Signature Validity is Unknown:  A yellow triangle with a signed document 
indicates that the Digital ID that was used to apply the digital signature is unknown and has 
not been verified.   

Note 1:  This is a normal occurrence when an expected change occurs as the form is 
processed through the Workflow.  Any change to the form will invalidate previously 
signed signatures. However, to revalidate, simply click on the Signatures Tab and click 
“Validate All” to validate all signatures in the document. 

Note 2:  This could also be due to the Adobe preference setting for Security not being 
set properly. To set or verify this preference, see Installing Digital Certificate – Prepare 
Adobe Reader. 

  Valid Signature, Modified Document:  A green arrow with a signed document and 
blue “i” (info) icon indicates that the document has been altered since that signature was 
first applied. 

 

   Validation Undetermined for one or more Signatures:  A magnifying glass with 
a signed document indicates that at least one signature requires validating. The icon 
appears on the Document Message Bar right above the form. 
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5.2.2.2 Checking When the Document was Signed 

You can check when the document was signed by viewing the time stamps of signatures. 
Do this by clicking the Signatures icon on the navigation panel or the Signature Panel 
button on the Document Message Bar (if using Adobe 9 or later) as shown in the example 
below. 
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5.2.3 Form Manager Icons 
The Adobe LiveCycle Form Manager will display several different icons that act as buttons to aid in 
the processing of the eForms.  The definitions below will help you recognize the difference between 
each of the icons used in the eForm Workflow process. The use of these icons is also covered in 
various Help Topics that include more information about their function in the workflow. 

 

  Attachment - Save: This icon of a paperclip with blue down arrow is found under the 
Attachments tab. Click on this icon to save a file attachment to your computer or an external device. 

 

  Attachment - Update: This icon of a paperclip with a blue up arrow is found under the 
Attachments tab. Click on this icon to upload an updated file attachment to the form. 

 

  Audit - View Assignments:  This icon is found in the Audit view of a task under the In 
Progress tab and the Archived tab. Click on this icon to view the assignments for the task. 

 

  Audit - View Attachments:  This icon is found in the Audit view of a task under the In 
Progress tab and in the Archived tab. Click on this icon to view the attachments for the task. 

 

  Audit - View Form:  This icon is found in the Audit view of a task under the In Progress tab 
and in the Archived tab. Click on this icon to view the form for the task. 

 

  Claim task and make it your own: This icon of an open lock is found under the Task Details 
tab of a shared task.  Click on this icon to claim the task and add it to your own Worklist for future 
work. 

 

  Claim and open task: This icon of an open lock with a blue right arrow is found under the 
Task Details tab of a shared task. Click on this icon to claim and open the task for immediate 
attention. 

 

  Delete: This trash can icon is found in the Worklist view and the Attachments tab. Click on this 
icon to delete a task or attachment. Only the initiator of the form or the attachment can perform this 
function. 

 

  Edit: This pencil icon is found in the Worklist view and in the Audit view of a task under the 
Archived tab to allow change of the task description. 
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  Favorites - Add: This hollow star is found in the Directory Panel. Click on this icon to add a 
form in the Favorites category. 

 

  Favorites - Remove:  This solid star icon is found in the Directory Panel. Click on this icon to 
remove a form from the Favorites category. 

 

  Forwarding: This icon is found in the Worklist view and Task Details tab. Click on this icon to 
forward a task to another user. In the Forwarding tab, this icon (with green arrow) appears next to 
the name of the user who will receive the forwarded task. 

 

  Lock: This lock icon is found under the Task Details tab. Click on this icon to lock the task 
and prevent others from claiming it. 

 

  Remove Task: This icon is found under the Task Details tab. Click on this icon to abandon 
the task and remove it from the Worklist view. 

 

  Save to Worklist (Draft): This icon is found in the Form tab to allow saving of a draft copy of 
the form for future editing. The same icon will also appear next to the form on the Worklist view, 
identifying that form/task as a saved draft. 

 

  Share(d) Task: In the Worklist view, this icon represents a shared task. In the Task Details tab, 
click this icon to share the task with another user. 

 

  Take Form Offline: This icon is found under the Form tab. Click on this icon to save a copy of 
the form on the computer or an external device. 
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5.2.4 Adding Notes 
You can add notes to relay important information to others involved in the Workflow. When a 
Workflow Form is sent to a Worklist, notes are delivered with the form. Other users who participate 
in the process can view, update, and delete the notes if you provide permission. It is recommended 
(good practice) to click on the Attachment tab upon opening a form in the Workflow to check for any 
notes that might have been posted.  

 

 
 

5.2.4.1 To Add a Note: 

1. Select Note in the Attachments tab. 

2. Type a title for the note in the Title box, and type the text for the note in the Note box. 

3. Select the Permissions level for the note for other users who participate in the process. 
Choose from the following levels: 

 Read Only - Users can only view the attachment 

 Read/Edit/Delete - Users can either read, edit, and/or delete the attachment 

 Read/Edit - Users can either read and/or edit the attachment. 

 Read/Delete - Users can read the attachment and/or remove it from the form 

 No access - The attachment icon is not visible to subsequent users. 

4. Click OK when done. A text file that contains your note is attached to the form. 
 

5.2.4.2 To Update a Note: 

If you have permission, you can update a note by clicking it and directly modifying the text.  
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5.2.4.3 To Delete a Note: 

If you have permission, you can delete a note by clicking the Delete icon  to the right of 
the note. A dialog box will appear to confirm the deletion. 

 

 
 

5.2.5 File Attachments 
Attachments in LiveCycle Form Manager are similar to attachments used in an email. When a 
Workflow Form is sent to a Worklist, attachments are delivered with the form. 

Attach files to the form to communicate supplementary information or to include files to the 
Workflow Form that others require to complete their task. Multiple attachments may be added, but 
they must be added one at a time. 

For Workflow Forms, files remain attached to the form until a user, who processes the form at a 
subsequent stage of the Workflow, deletes them.  

Attachments have permissions that determine what can be done with them. Depending on the 
permissions granted, the user can view, modify, or delete attachments. When attaching a file to a 
form, specify the permissions that determine what can be done with the file at subsequent stages of 
the Workflow. Configure the permissions after attaching the file. If attaching more than one file, set 
different settings for each attachment. 

When accessing a form in the Archived tab, any attachments associated with the forms are read-
only, regardless of how the permissions were originally set. If an attachment must remain with a 
Workflow form for all subsequent stages of the Workflow, choose a permission that does not allow 
other users to delete the attachment. 

Files uploaded to this system cannot exceed 8 ½ by 11 or European A4 (Portrait or Landscape) or 
larger than 5MB. For additional information, see File Upload Limitation for list of acceptable file 
types.  Password-protected or restricted documents will not be accepted for upload in the Form 337 
workflow. Although there are no limits to the number of attachments, the more attachments there 
are in the Workflow, the longer it will take to submit or retrieve the Form 337. 

 

NOTE:  Do not attach password-protected or permission-restricted files to your Form 337 
submission as these files cannot be processed.  The restrictions on these attachments block 
the processing of the Form 337 submission for delivery to Registry. 

 

NOTE:  Instead of clicking the "X" at the top right corner of the window after working with 
attachments, it is good practice to go back to the Form tab to either save the form as draft or 
click the Complete button when you are ready to forward the form to the next step in the 
workflow. This is because any edits to the form made prior to working on attachments are 
not saved if you click the "X" and then select "Yes" to close the form.  
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5.2.5.1 Adding a File Attachment 

NOTE:  Files you attach will be downloadable and viewable by others.  However, only you 
as the Initiator can delete them from the Workflow Attachment section.   

1. Click the Browse button to the right of the Name box and select the file to be attached. 
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2. In the Permissions list, select the Permissions level for the file. Choose from the 
following levels: 
  

 Read Only - Users can only view the attachment 

 Read/Edit/Delete - Users can either read, edit, and/or delete the attachment 

 Read/Edit - Users can either read and/or edit the attachment 

 Read/Delete - Users can make read the attachment and/or remove it from the 
form 

 No access - The attachment icon is not visible to subsequent users. 

 

3. In the Type list, choose Send to Registry or Do not Send to Registry. 

NOTE: All documents identified as "Send to Registry" are publicly available. When 
attaching documents with proprietary supplemental information for the repair or alteration, 
you need to select "Do Not Send to Registry" if you do not intend for it to be available to the 
public. 
 

 
  

4. Click OK when done. 
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5.2.5.2 File Upload Limitation 

 

There are four limitations to all files attached in the Form 337 workflow.  

 

1. Only the following file types can be attached in the Form 337 workflow. 
  

Microsoft Office Word Document (specifically .doc and .docx) 

Adobe PDF file (specifically .pdf) 

Plain Text file (specifically .txt) 

Rich Text file (specifically .rtf) 

Image files (specifically .jpg, .jpeg, .gif, .tiff, .tif, or .eps) 

Microsoft Bitmap image files (specifically .bmp) 

Microsoft Visio (specifically .vsd) 

Microsoft Office Excel Spreadsheet (specifically .xls and .xlsx) 

Microsoft Office PowerPoint Presentation (specifically .ppt and .pptx) 

PostScript Print files (specifically .ps) 

AutoCAD (specifically .dwg) 

   

2. Each file attachment must be 5MB or less. 
  

3. Only 8 ½ by 11 or European A4 (Portrait or Landscape), or smaller, will be accepted by 
Aircraft Registry.  If a file is greater than this dimension, the upload will fail and a 
message will appear for the user to resize the document and try the upload again. 
  

4. Password-protected or restricted documents will not be accepted for upload in the Form 
337 workflow. A time-out message will appear after a period of time with instructions to 
verify whether the file is password-protected or restricted. The user needs to remove 
the password or restriction and try to upload again. 
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5.2.5.3 Saving an Attachment 

     

 
 

To Save an Attachment: 

1. Click on the Save icon  to save the file to a folder in your computer or an external 
device. 

2. When the "Select location for download..." box opens, select the location to save the 
file.  

3. Enter a file name or leave as is, then click the Save button.  

4. A dialog box appears to confirm that you have saved the attachment. Click the OK 
button. 

 

NOTE:  Clicking the file name will also bring up a File Download box that provides another 
way to save the attachment in your computer or an external device. 
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5.2.5.4 Updating an Attachment 

If you have permission to update the attachment, an Update icon  appears to the right of 
the file. 

To Download and Edit an Attachment:   

 

 

 
To update a Workflow attachment, save the file to the computer, edit it, and upload the 
updated file, do the following steps:  

1. Click the Save icon to the right of the attachment to be updated. The "Select location 
for download..." box appears. 

2. Select the location on the computer to save the file and click the Save button. DO NOT 
change the name or the extension of the file. 

3. Open the file from where it was saved and edit as necessary. After completing work on 
the file, save it. 

4. Back on the Form Manager, click on the Update icon . The "Select file to upload..." 
box opens. 

5. Locate and select the updated file. 

6. Click the Open button.  

7. A confirmation box appears. Click OK to update the attachment. The updated file is 
attached as indicated under "Date last Modified". 

 

Note:  If for any reason a document cannot be opened and edited: 

 The document has read-only permissions. 

Solution: Contact the original creator of the document. 
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 The document is not supported by any programs on the computer. 

Solution: Contact the AVS National Service Desk and notify them of the problem. 

 

Note:  If for any reason a document cannot be updated on the Workflow form: 

 The document is named incorrectly. 

Solution: Rename the edited file with the same File Name listed on the Workflow 
Forms Attachment Section. If the file will still not upload, contact the AVS National 
Service Desk and notify them of the problem. 

 

5.2.5.5 Deleting an Attachment 

If you have permission to delete the attachment, a trash icon  appears to the right of the 
file. 

 
  

1. Click on the trash can icon  to the right of the attachment to be deleted. A dialog box 
will appear to confirm the deletion of the attachment (see example below). 

 

 
  

2. Click OK to delete; otherwise, click Cancel to go back to the Attachment window. 

3. After selecting the OK button, another dialog box will confirm that you have deleted the 
attachment. Click OK. 
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5.2.6 Forwarding a Task 
The Forward function can be used to forward a task to another user for review purposes, 
collaboration, or assistance in completing a form. This does not submit the form or route it to the 
next stage in the workflow process. (NOTE:  If routing a Form 337, see Complete Button and 
Routing Information.) 

Forwarding a task can be done from either the Worklist tab or from the Task Details tab, as shown 
in the examples below. 
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1. Click the Forwarding icon to open the Forwarding window as shown below. 

 

 
  

2. To locate a user, type the user's name in the text field and click the Find button or press Enter 
on the keyboard. 

NOTE:  You can enter either the first name or the last name (not both) or the format of 
(lastname, firstname). User name is not case-sensitive.   

3. Select the desired user from the list (see example below) and click on the Forwarding icon  
next to the user name. The result of the search may return more than one name (i.e., for the 
last name Smith).  Scroll down the list and select the appropriate individual. 
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4. Click the Add button to add the user to the Recipient list. 

5. Click OK to forward the task. 

 

5.2.6.1 Returning a Forwarded Form 

1. To return the forwarded task or form back to the sender, open the form in the Worklist. 

2. On the Task Details tab, click the “Return this task to the previous user” icon on the 
bottom of the window. 
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3. The form disappears from your Worklist view and a yellow message bubble appears on 
the top menu bar to notify you that the form has been added to the previous user’s 
Worklist queue. 
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5.2.7 Changing Task Description 
The description for each task can be changed (or added) while in Worklist view or in Archived 
view. See examples below. 

   
NOTE:  This description is used for organizing your own Worklist and Archived views and does not 
go with the task when it is sent to the next stage of the workflow process. The only exception is 
when the task is forwarded to another user since the description stays only with forwarded tasks. 
  

5.2.7.1 Changing Task Description in Worklist View 

Click inside the Description section of the task and type the description in the text box. 
Press Enter on the keyboard or click outside the text box when finished.  

 

  
 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
44 

5.2.7.2 Changing Task Description in Archived View 

For the Archived view, there are two ways to change the task description: 

1. One way is by clicking inside the Description section of the task and typing the 
description in the text box. Press Enter on the keyboard or click outside the text box 
when finished. 
  

 
  

2. Another way is by double-clicking on the task in the Archived view above to open it and 

then selecting the Audit tab. Click once on the task and the Edit icon  appears on 
the left bottom corner of the window, as shown in the example below. The Edit icon is 

also visible when clicking on the View icon  to open the form. 
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3. Click on the Edit (Pencil) icon and the "Change Task Description" window appears for 
you to enter the description of the task.  

 

 
  

4. Click Save when done or Cancel to go back to Audit view. 

 

5.2.8 Claiming a Shared Form 

Form 337 users can claim a shared task by performing the steps below. Shared tasks have the  
icon to the left of the tasks. 

 
1. Double-click on the shared task to open it. 
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2. The Task Details window opens. Click on the left icon  to claim the task and add it to your 

own Worklist for future work. Click the right icon  to claim and open the task for immediate 
attention. 
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5.2.9 Saving to Worklist (Draft) 
If you need to save the form for future editing or completion, you can save a draft copy of a form so 
that you do not lose your existing work. This does not submit the form.  

1. With the Form tab open, click the Save (Save to Worklist (Draft)) button on the bottom left 
corner of the form.  

 

 
 
 

2. A confirmation bubble briefly appears to confirm that the form has been saved to the Worklist 
view. 
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3. When you exit the form and go to the Worklist view, the Save to Draft icon appears next to the 
form (see example below). 
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5.3 Advisory Circular 

5.3.1 Table of Contents 
 

AC No:  43.9-1F 

Date:  1/25/07 

Change: 

Initiated by:  AFS-340 

Subject:  Instruction for Completion of FAA Form 337  

 
1. Purpose 

2. Cancellation 

3. Related Regulations 

4. Information 

5. Electronic Format 

6. Instructions for Completing FAA Form 337 

7. Administrative Processing 

8. Appendix I 

 

5.3.2 Purpose 
 

This Advisory Circular (AC) provides instructions for completing Federal Aviation Administration 
(FAA) Form 337, Major Repair and Alteration (Airframe, Powerplant, Propeller, or Appliance). 

 

5.3.3 Cancellation 
 

AC 43.9-1E, Instructions for Completion of FAA Form 337 (OMB No. 2120-0020), Major Repair and 
Alteration (Airframe, Powerplant, Propeller, or Appliance), dated 5/21/87, is canceled. 

 

5.3.4 Related Regulations 
 

Title 14 of the Code of Federal Regulations (14 CFR) part 43, C++ 43.5, 43.7, 43.9, and Appendix 
B. 
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5.3.5 Information 
 

FAA Form 337 is free and available at all FAA Manufacturing Inspection District Offices, Flight 
Standards District Offices (FSDO), International Field Offices, Certificate Management Offices, and 
online at http://eformservice.faa.gov/Forms/FAA/F337ARE.pdf 

 
1. The form serves two main purposes: 

  

a. To provide aircraft owners and operators with a record of major repairs and alterations, 
indicating the details and approvals. 

b. To provide the FAA with a copy of the form for inclusion in the aircraft records at the FAA 
Aircraft Registration Branch, AFS-750. 
  

2. This form can be completed on paper or by using the FAA electronic Form 337. Information can 
be found online at http://eformservice.faa.gov/eForm337.aspx or by contacting your local 
FSDO. 

 
 

5.3.6 Electronic Format 
 

Electronic Tracking Number. In the upper right corner of the form’s header, a block has been 
provided titled “Electronic Tracking Number.” This block is used only in the electronic version to 
automatically apply a number that identifies and retrieves forms electronically.  
  

Watermark. Under current policy, the header block titled “For FAA Use Only” has no official use 
except as a watermark applied automatically to indicate submittal when using electronic media. 

 

 

http://eformservice.faa.gov/Forms/FAA/F337ARE.pdf
http://eformservice.faa.gov/eForm337.aspx
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5.3.7 Completing the Form 337 
 

The person who performs or supervises a major repair or major alteration must prepare the Form 
337. The form is executed at least in duplicate and is used to record major repairs and major 
alterations made to an aircraft, airframe, powerplant, propeller, appliance, or a component part 
thereof. The following instructions apply to items 1 through 8 of the form as illustrated in Appendix 
1. The terms “Item” and “Block” are used synonymously in FAA documents relating to data 
collection on Form 337. 

1. Item 1– Aircraft. The “Nationality and Registration Mark” is the same as shown on Aircraft 
Certification (AC) Form 8050-3, Certificate of Aircraft Registration. An “N” prefix denotes the 
nationality for U.S. registered aircraft. Information to complete the "Make”, “Model”, and “Serial 
Number” blocks is found on the aircraft manufacturer’s identification plate. A “Series” block has 
been provided to further identify the series of a specific model. Proper segregation of the model 
and series will be useful in collecting data for safety-related issues. 

NOTE:  When the aircraft registry receives a completed Form 337 for the official aircraft file, it is 
validated by matching the registration “N” number with the serial number. If an application for a 
change to the “N” number has been made, it is important for the submitter to receive verification 
of the change from the FAA registry with a new AC Form 8050-3. If the Form 337 must be 
submitted before receipt of the new registration, then the old “N” number must be used. 

2. Item 2 – Owner. Enter the aircraft owner’s complete name and address as shown on AC Form 
8050-3. When work is performed during a change in ownership, it is permissible to use the 
name and address shown on AC Form 8050-1, Aircraft Registration Application. 

NOTE: When a major repair or major alteration is made to a component part, items 1, 2, and in 
some cases 5 will be left blank and the original and duplicate copies of the form will remain with 
the part until it is installed on an aircraft. After entering the required information in items 1, 2, 
and if appropriate, 5, the person who installed the part will give one form to the owner/operator 
and forward the duplicate copy to the FAA registry within 48 hours after the aircraft is approved 
for Return to Service. If a component part of an airframe, powerplant, propeller, or appliance is 
repaired or altered and the unit identification information is not known, it is appropriate to apply 
the preceding procedure and leave item 5 blank until the airframe, powerplant, propeller, or 
appliance is installed on the aircraft. 

3. Item 3 – For FAA Use Only. Indicate approval in item 3 when the FAA determines that data 
used to perform a major repair or major alteration conforms to accepted industry practices and 
is in compliance with current guidance and regulatory requirements. Approval is indicated by 
one of the following methods. (See paragraph 7, Administrative Processing, for further details.) 

a. Approval of Data by Examination Only. Enter the following statement on Form 337 when 
the data package is reviewed and a data approval is completed: 

“The data identified herein complies with the applicable airworthiness requirements and is 
approved for the above described aircraft, subject to conformity inspection by a person 
authorized in section 43.7.” 

b. Approval of Data by Physical Inspection. Enter the following statement on Form 337 
when a physical inspection, demonstration, or other type of test of an aircraft is satisfactorily 
performed and an installation approval is completed: 
 
“Approval by Physical Inspection, Demonstration, Testing, etc.—One Aircraft: The alteration 
or repair identified herein complies with the applicable airworthiness requirements and is 
approved for the above described aircraft, subject to conformity inspection by a person 
authorized in section 43.7.” (Order 8300.10, vol. 2, ch. 1, section 2, paragraph 5d(3).) 
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c. Designated Airworthiness Representative Statement of Completeness. Authorized 
designee certification of data indicates that the data in item 8, Description of Work 
Accomplished, comes from FAA-approved sources and addresses all the original 
certification requirements for the aircraft described in item 1. It does not constitute a field 
approval or approval of the data. Enter the following statement when an authorized 
designee has reviewed and certified the alteration data package by signing, dating, and 
entering its designee authorization number in item 3: 
 
“The alteration identified herein has been reviewed and found to be complete with 
appropriate Designated Engineering Representative approvals. All aspects of the 
alteration(s) are compatible and eligible for use on the above described aircraft, subject to 
conformity inspection by a person authorized in § 43.7.” (Order 8300.10, vol. 2, ch. 1, 
section 1, paragraph 15c.) 

d. Overweight Aircraft Operating Under a Special Flight Permit. Enter the following 
statement as part of the recordkeeping requirements for overweight flight permits contained 
in the current edition of FAA Order 8130.2, Airworthiness Certification of Aircraft and 
Related Products: 
 
“No person may operate this aircraft, as altered herein, unless it has within it an appropriate 
and current special flight permit issued under part 21.” (Order 8130.2F, paragraph 196b.) 

4. Item 4 – Type. Enter a checkmark in the appropriate column to indicate whether the unit was 
repaired or altered. Use only one “Type” line per form. 

5. Item 5 – Unit Identification. Use the information blocks under item 5 to identify the airframe, 
powerplant, propeller, or appliance that has been repaired or altered. It is only necessary to 
complete the blocks for the unit repaired or altered. The procedure for repair or alteration of a 
component part when the unit identification is unknown is detailed in paragraph 6b above. Use 
only one “Unit Identification” line per form. 
 
NOTE: A component of an airframe, powerplant, propeller, or appliance repaired or altered 
must be clearly identified in item 8 listing the part number, serial number, and any other 
descriptive information as applicable. 

6. Item 6 – Conformity Statement. 

a. “A” – Agency’s Name and Address. Enter the name of the certificated person or entity 
accomplishing the repair or alteration. Mechanics should enter their name and permanent 
mailing address. Manufacturers, repair stations, and certificated maintenance organizations 
should enter the name and address under which they are certificated. 
  

b. “B” – Kind of Agency. Check the appropriate box to indicate the type of person or 
organization that performed the work. 
 
NOTE: For the purposes of this form, a Canadian Approved Maintenance Organization is 
considered a foreign mechanic. 
  

c. “C” – Certificate Number. Enter the appropriate certificate number for the “Kind of 
Agency” entered in item 6b of the form. Mechanics should enter their mechanic’s certificate 
number. Certificated maintenance organizations and repair stations should enter the 
number referenced on the air carrier, air operator, or air agency certificate issued by the 
FAA as appropriate. Manufacturers should enter their Production Certificate or 
Supplemental Type Certificate number as appropriate. When repairing or altering articles, 
manufacturers holding Technical Standard Orders (TSO) approvals should enter the TSO 
number of the affected article. 
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d. “D” – Compliance Statement. Use this space to certify that the repair or alteration 
complies with 14 CFR part 43. When work was performed or supervised by certificated 
mechanics, they should enter the completion date of the repair or alteration and sign their 
full name. Repair stations and maintenance organizations are permitted to authorize their 
employees to date and sign this conformity statement to comply with their FAA-approved 
program. 
  

e. Fuel Tank Modification. For modifications involving installation of extended range fuel 
tanks in the passenger or baggage compartment as described in part 43, appendix B, 
check the box provided to indicate the modification. 
 
NOTE: In this instance, one copy of Form 337 must be placed onboard the aircraft as 
specified in 14 CFR part 91, § 91.417 when the aircraft is returned to service. 
  

7. Item 7 – Approval for Return to Service. Part 43 establishes the conditions under which 
major repairs or major alterations to airframes, powerplants, propellers, and appliances may be 
approved for return to service. This portion of the form is used to indicate approval or rejection 
of the repair or alteration and to identify the person or agency making the airworthiness 
determination. 
  

a. Check the “approved” or “rejected” box to indicate the finding. Rejected forms will be 
returned to the person who made the modification, as identified in item 6, for correction. 
Approved forms will be completed, signed, and submitted to the aircraft registry. 
  

b. Check the appropriate box to indicate who made the finding. Use the box labeled “other” to 
indicate a finding by a person other than those listed. This box is reserved for any entity, not 
otherwise identified, that the FAA may authorize to perform that function. The person who 
made the finding should sign and date the form. The person’s name should also be typed or 
printed below their signature and the appropriate certificate or designation number should 
be entered. If an aviation safety inspector (ASI) signs item 7, the ASI’s office identifier is 
placed in the certificate or designation number block. 
  

c. Before approving Form 337, it is the responsibility of the person returning the product to 
service to ensure that all the work described in item 8 match approved data and that the 
information presented on the form is complete. 
  

d. If the form is not accepted by the aircraft registry for any reason, it will be routed through 
the FAA regional office back to the return to service agent identified in item 7. 
  

8. Item 8 – Description of Work Accomplished.  
  

a. Enter a clear, concise, and legible statement describing the work accomplished in item 8 on 
the reverse side of Form 337. It is important to describe the location of the repair or 
alteration relative to the aircraft or component. If making a repair to a buckled spar, the 
description entered in item 8 might begin by stating, “Removed wing from aircraft and 
removed skin from outer 6 feet. Repaired buckled spar 49 inches from the tip in accordance 
with…” and continue with a description of the repair. If the repair or alteration can be 
concealed by skin or another structure then an authorized individual should make a pre-
closure certification statement. This statement includes a signature and certificate number 
and says that a pre-closure inspection was made and that covered areas were found 
satisfactory. 
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b. The description should refer to all applicable 14 CFR sections and to the FAA-approved 
data used to substantiate the airworthiness of the repair or alteration. Forms of FAA-
approved data are contained in Order 8300.10 and AC 43-210, Standardized Procedures 
for Requesting Field Approval of Data, Major Alterations, and Repairs. 
 
NOTE: Supplemental data such as stress analyses, test reports, sketches, or photographs 
are often proprietary and not intended as part of the item 8 description. Supplemental data 
submitted as part of the item 8 description should be identified as an attachment to the form 
using the following procedure.  

c. If additional space is needed to describe the repair or alteration for item 8, check the 
“Additional Sheets Are Attached” box at the bottom of the page. Attach sheets showing the 
aircraft nationality, registration mark, and the date the work was completed. All attachments 
to item 8 must be submitted on 8 ½- by 11-inch paper to allow for proper processing into 
the aircraft historical record at the aircraft registry. If attachments to Form 337 are received 
by the FAA in a format larger than an 8 ½- by 11-inch page, then the submission will be 
returned to the person identified in item 7 for correction and resubmission. 
  

d. Showing weight and balance computations under item 8 is not required but it may be done. 
If weight and balance of the aircraft are affected by the work described on Form 337, the 
changes should be entered in the aircraft weight and balance records with the date, 
signature, and reference to the form. 

5.3.8 Administrative Processing 
Form 337 will be executed in duplicate with one signed copy given to the aircraft owner and one 
copy forwarded to the FAA within 48 hours after the airframe, aircraft engine, propeller, or appliance 
is installed on an aircraft and approved for Return to Service. FAA processing of the forms and their 
supporting data will depend on whether approved or unapproved data is used. 

1. Approved Data. Complete the form as instructed in this AC, excluding item 3, and ensure that 
items 6 and 7 have been properly executed. Give a copy of the form to the aircraft 
owner/operator and send a duplicate copy to the FAA Aircraft Registration Branch within 48 
hours after the airframe, aircraft engine, propeller, or appliance is installed on an aircraft and 
approved for return to service. 

2. Unapproved Data. Complete the form as instructed in this AC, leaving items 6 and 7 blank. 
Both copies of the form and any supplemental data will be sent to the local FAA district office. 
When the FAA determines that the major repair or major alteration data complies with 
regulations and conforms to accepted industry practices, data approval will be recorded by 
entering an appropriate statement in item 3. Both forms and any supplemental data will be 
returned to the applicant who will then complete items 6 and 7. The applicant will give one of 
the completed forms to the aircraft owner/operator and submit the other completed form to the 
FAA Aircraft Registration Branch for inclusion in the aircraft records. 

NOTE: The electronic FAA Form 337 allows for electronic approvals and processing of Form 
337 from the time it is used to describe the alteration or repair until it is forwarded to the FAA 
Aircraft Registration Branch. At this time the FAA does not allow for the mixing of the two 
processes. If Form 337 is started in the electronic format, it must be completed that way and 
cannot be completed using the paper process. Further information is supplied at the Web site 
shown in paragraph 4(b). 

3. Signatures on Form 337.  

a. An FAA inspector’s signature in item 3 indicates approval of the data described in that 
section for use in accomplishing the work described in item 8 of the form. The statement of 
completeness in item 3 by an appropriately rated designee is a “certification of 
completeness” of required data. It is not a field approval or approval of data. 
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NOTE:  Signatures in item 3 count as data approval or completeness of approved data only 
and do not indicate the approval for return to service for the work in item 8. 
  

b. A signature in item 6 is a certification by the person performing the work that the work 
complies with all applicable airworthiness requirements and FAA-approved data. The 
certification is only applicable to the work described in item 8 or attached sheets. 
  

c. A signature in item 7 by an FAA Flight Standards Inspector or Designee constitutes an 
authorized Return to Service. A signature is not an approval of data. Data approval 
procedures are performed in item 3 by an authorized individual and further defined in Order 
8300.10 and AC 43-210. Other persons listed in item 7 are authorized to “approve for return 
to service” if the major repair or major alteration uses and conforms to FAA-approved data 
and is performed in compliance with part 43. 
  

d. If engineering assistance was requested, written Aircraft Certification Office concurrence 
(e.g., memo or e-mail) becomes an attachment to Form 337. 
  

4. U.S. Military and Foreign Use. Form 337 is not authorized for use with aircraft not registered 
in the United States. The form may be provided to the U.S. Military or a foreign civil air authority 
if it is requested as a record of work performed and should be completed following part 43 and 
this AC. A note on the form should inform the U.S. Military or foreign authority that the form is 
not an official record and that the FAA aircraft registry will not record it. 
  

5. Completed Forms. Completed forms should be submitted to the Aircraft Registration Branch, 
AFS-750, PO Box 25504, Oklahoma City, Oklahoma 73125. Electronic forms are submitted 
automatically through the website at: http://eformservice.faa.gov/eForm337.aspx. 
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5.3.9 Appendix I 
FAA FORM 337 
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FAA FORM 337 (Page 2) 

 
 

Related Topic: 

 
Table of Contents 
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5.4 FAA Personnel Users 

5.4.1 Login as FAA Personnel 
To enter the eForm system as an FAA Personnel User, follow the login procedure below. 

 
1. Access the http://eformservice.faa.gov/eform337.aspx web site. 

2. Under AVS Form Manager Access on the right side of the home page, click on the Log Into 
eForm Service link. 

 
  

http://eformservice.faa.gov/eform337.aspx
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3. A Warning page appears as shown below. To proceed to the eForm Service login page, click 
on the I Agree to these terms button. 
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4. The eForm Service Access page appears. Enter the username and password that you use to 
access your computer and then click the Login button. 

NOTE: Ignore the Default Login checkbox if you are an AVS user or an external user who is not 
a member of a certificated organization. See Default Login Help Topic under eForms Help 
Directory for more details. 

 

 
 

NOTE:  After three attempts of entering the wrong login information, the system will log you out. 
The following message appears, instructing you to close the browser, reopen it, and re-navigate 
back to the Login page. 
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5. After successful login, the LiveCycle Form Manager page is displayed and the login name 
appears in the upper right corner of the page. 
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5.4.2 FAA Access Permission Process 
When a change is needed for the User Account Request function for the Form 337 program, please 
request additions or removals from the local office 337Requester group following the current AVS 
National Service Desk procedures. 
  

Follow the instructions below when there is a change to the ASI’s in your office who have been 
authorized to do Form 337 Field Approvals: 
  

1. When a current ASI with Field Approval authority no longer has that function or moves to 
another office, please submit a request for the removal of the ASI from the local 337User group 
following the current AVS National Service Desk procedures.   
  

2. When an ASI has been newly authorized to perform Form 337 Field Approvals within your 
office: 
  

a. Submit a request for adding the user's AVS account to the local 337User group. 

b. Submit an email with the following information on the new office ASI(s) authorized to 
perform 337 Field Approvals to the AVS National Service Desk. They will create a request 
ticket with that information and assign it to the Form 337 IT Program Manager, who will 
make the official request to Team Askin: 
  

Office Name (i.e., Oklahoma City FSDO): 
Office Identifier (i.e., SW15, or SW00): 
Legal Signature name (i.e., James J. Doe): 
Title (i.e., ASI, PMI): 
Email: 
Telephone #: 
Extension (if applicable): 
Location (City, State): 
AVS User ID (i.e., ASW214MB): 

 
 
 
Related Topics: 
 
Form 337 Active Directory Account Admin 
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5.4.3 Form 337 Active Directory Account Admin 

5.4.3.1 Form 337 Group Setup 

1. The groups below should be created in the Office’s USR Organizational Unit (OU) in 
Active Directory (AD). 

a. XXXYYY0GRP_337User 

b. XXXYYY0GRP_337Requester 

NOTE:  XXXYYY represents the office ID (ex. Fairbanks FSDO would be 
AAL2010GRP_337User and AAL2010GRP_337Requester) 

 

2. When the groups are created, the Computer Specialist should email this information to 
AVS National Service Desk (NSD), so they can add the local groups to the National 
Form 337 Groups. 

3. The NSD will add the local groups to the national groups. 

a. The 337User group will be added to the AFS0000GRP_337ASI group. 

b. The 337Requester group will be added to the AFS0000GRP_337UserRequest 
group. 
  

5.4.3.2 Form 337 Internal User Setup 

1. The Office Manager will supply the Computer Specialist with the user information. 

a. The Office Manager should supply a list of the office’s ASIs with Field Approval. 

b. The Office Manager should supply a list of personnel who can collect/validate 
Industry user information. 

2. Each of the user’s accounts in AD must be updated to include the following information. 

a. First Name: must contain the user’s first name 

b. Last Name: must contain the user’s last name 

c. Display Name: must contain Last Name, First Name 

d. Office Field: must contain ‘4-letter office identifier’ (Example: Fairbanks FSDO 
would be AL01) 

e. Telephone Number: must contain the user’s phone number ###-###-#### x### 

f. E-mail: must contain the user’s FAA email address (Example: John.doe@faa.gov) 

3. The Computer Specialist should place the users with Field Approval into the office’s 
337User Group. (Example:  xxxyyygrp_337user) 

4. The Computer Specialist should place the users who can collect/validate Industry user 
information into the office’s 337Requester group. (Example:  xxxyyygrp_337requester) 

5. Offices without a Computer Specialist will need to request these group memberships 
via their manager. The manager should email the National Service Desk with 
permission to add the group. 
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5.4.3.3 Form 337 External User Setup 

1. There are two types of external account requests for access to eForm 337: External 
Individual Account Requests and Certificated Organizational Accounts. Both types of 
account requests should be escalated to eForms Tier3 for completion. 

2. Tier 3 will initiate the external account request via AVS Provisioning and notify the NSD 
when the ticket should be closed. 

3. The new external user will be notified through an automated message from AVS 
Provisioning that the account has been initiated. 

5.4.3.4 Form 337 External Disabled Accounts 

1. The National Service Desk will escalate all requests for permission to enable 337 
external account to the eForm Service Tier 3 group. 

2. The eForm Service Tier 3 group will determine if the account can be enabled. 

3. If the account can be enabled, the eForm Service Tier 3 group will send an email 
message to nsdupdate@faa.gov. The email message will ask for the ticket to be 
reassigned to an NSD analyst and will contain permission to enable the account. The 
NSD analyst will enable the account, communicate with the customer, and resolve the 
ticket. 

4. If the eForm Service Tier 3 group determines that the account cannot be enabled, an 
email will be sent to nsdupdate@faa.gov. The email message will ask for the ticket to 
be reassigned to an NSD analyst and will contain the reason why the request was 
denied and the contact information. The NSD will communicate with the customer and 
resolve the ticket. 

5.4.3.5 Form 337 External User Profile Update 

Requests from an external user to update his/her 337 profile can be handled by the user via 
the AVS Portal. The NSD or eForms Tier 3 group also has the ability to update the user’s 
337 profile via AVS Provisioning. 

 

mailto:nsdupdate@faa.gov
mailto:nsdupdate@faa.gov


Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
65 

5.4.4 User Account Request 

5.4.4.1 For Individual Accounts 

IMPORTANT NOTE:  This process applies only to individuals who are not employed by any 
certificated organization.  Industry users should contact the local Flight Standards District 
Office and present their maintenance certificate. A representative of the FSDO will request 
the account creation by completing the following steps. 

1. Log in to eForm Service following instructions under Login as FAA Personnel.  

2. In Form Manager, click on the eForms Admin link on the top menu bar.  

 

 
 
  

3. The eForms Admin page opens as a separate window. Click the Individual Account 
Request link.  

 

 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
66 

 
NOTE:  If you do not have permission to perform any of the functions pertaining to the 
eForm Service, the following page appears. Contact the AVS National Service Desk as 
necessary for questions or further instructions. Click Close Window on the top right corner 
of the page and go back to the Form Manager. 

 

 
  

4. If you are authorized to perform various functions pertaining to the eForm Service, you 
are directed to the Individual User Account Request page as shown below. Fill in all 
applicable information for the Industry User, including multiple certificate numbers. 
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5. If entering information for multiple users, click the Submit Another button, and repeat 
steps 1 through 4. 

6. After entering the last Industry User information, click the Submit & Exit button. 

7. The Industry User profiles are submitted to the AVS National Service desk for 
processing. The Service Desk personnel will create the account based on the submitted 
information. 
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5.4.4.2 For Certificated Organizations 

IMPORTANT NOTE:  This process applies only to individuals who are also employed by 
any certificated organization(s). Follow the same process for changes (additions or 
removals).  For request from Repair Stations or Maintenance Organizations with several 
Industry Users, follow the steps below. 

1. Access the eForm Service following instructions under Login as FAA Personnel. 

2. In Form Manager, click the eForms Admin link on the to menu bar. 

 
 

3. The following eForm Service page opens as a separate window. Click the Certificated 
Organization User Account Request link. 

 

 
 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
69 

NOTE:  If you do not have permission to perform any of the functions pertaining to the 
eForm Service, the following page appears. Contact the AVS National Service Desk as 
necessary for questions or further instructions. Click Close Window on the top right corner 
of the page and go back to the Form Manager. 

 
 

 

4. If you are authorized to perform various functions pertaining to the eForm Service, you 
are directed to the “Certificated Organization User Account Request Procedures” page. 
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5. Click the Certificated Organization User Account Request Spreadsheet link to open 
or save a copy of the spreadsheet (see spreadsheet example below).  Please ensure 
accurate contact information (phone/email) is entered in case there are questions about 
the user request. 
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6. Upon receipt of an email with the completed user account request spreadsheet for any 
organization (i.e. Repair Stations, Foreign AMO's and 121, 135, 91K certificate holders 
with a Continuous Airworthiness Maintenance Program (CAMP)), please review and 
verify all the information provided and forward the spreadsheet with a statement 
approving the creation of these accounts to their local computer specialist, who will 
forward the request to AVS National Service Desk. (Existing protocol dictates that the 
Service Desk personnel will only accept requests for organizational account requests or 
changes from the local office computer specialist.) 

7. Once received, the AVS National Service Desk personnel will begin the process of 
creating the user accounts. They will initiate the account(s) and send out automated 
email notifications with instructions. The process is as follows: 

 The new user will receive an email that includes a link to the AVS Provisioning 
Service Portal for user registration with a temporary password. 

 After the user has successfully registered the account, a second email with the 
user login ID will follow. 

 The FAA POC will receive an email confirmation upon completion of the new 
account. 

Once the certificated organization’s account is established, it is up to the 
organization’s internal processes to determine task assignment and control. 
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5.4.5 Document Approval Process 

5.4.5.1 Signing and Certifying Approved Documents 

This Help topic demonstrates how an ASI, an authorized DAR, or an ACO POC converts, 
signs, and certifies supporting documents included with Form 337 submission. 

Converting a Word document received in email to Adobe PDF 

1. Detach the document from email and save it to a local or network drive. 

2. Open the document. 

3. Review and coordinate changes as necessary until ready to approve. 

4. When ready to approve the document and digitally sign, perform the following functions: 

a. With the document open, select File > Print.  From the available printers, select 
Adobe PDF.  Click OK. 
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b. From the following prompt, ensure that the drive location for the PDF file is 
accurate and click SAVE. 

 
  

Signing and Certifying a PDF Document 

1. With the File open in Adobe Professional, select Sign > Certify with Visible Signature 
from the Menu bar. 
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2. The Save As Certified Document dialog appears. Click OK. 
 

 
 
 
  

3. Click OK when prompted to create the signature field. 
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4. With your mouse, drag and draw the area where you wish to sign. 

 

 
  

 

5. Select your digital signature from the drop-down box and select "No changes allowed" 
for the second drop-down box. Then, click the Sign button. 
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6. The Save As dialog box appears. Select the appropriate folder, save document using 
the same file name, and click the Save button. 

 

 
 
  

7. Enter your digital certificate password and click OK. 
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8. Your digital certificate is applied to the signature field. 

 

 
  

9. If the approved document is signed by the ACO POC, they must return the certified and 
signed PDF document to the ASI or authorized DAR by the same method it was 
received (i.e. Forwarding or Emailing). The ASI or authorized DAR can then attach the 
document to the Form 337. 
 
NOTE:  Do not password-protect the certified/signed PDF document.  It is not 
necessary and will cause problems when the document is eventually processed 
for delivery to Aircraft Registry. 
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5.4.5.2 ASI/DAR and ACO Coordination 

 

In some instances an Aviation Safety Inspector (ASI) or authorized Designee has the need 
to coordinate the review or approval of supplemental or supporting documents included with 
Form 337 submission (see Signing and Certifying Approved Documents). 

 

A supplemental document is a document that provides supplemental information to the ASI 
or DAR in support of the modification but is not considered an attachment to the Form 337. 
Therefore, the document is selected as 'Do Not Send to Registry' (for example, proprietary 
information such as an engineering report). 

  

A supporting document is a document that is essentially part of the Form 337 or an 
extension of Block 8 and supports the description of the work to be accomplished.  At times 
a document may need an approval signature (i.e., an Addendum to a Flight Manual 
Supplement).  This document is one that would be attached with the 'Send to Registry' 
selection and would, therefore, be delivered to Registry along with the Form 337. 

 

After a determination that coordination between the ASI/DAR and ACO is needed, the 
system provides two methods to accommodate the transfer of information.  The preferred 
method is Forwarding the Form 337 file to the ACO point of contact (POC).  The alternate 
method is Emailing the attachment back and forth between the ASI/DAR and the ACO 
POC. 
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Forwarding Form 337 

 

The ASI or an authorized DAR can forward the Form 337 task to their ACO POC to 
complete the approval process of the attached document (i.e. Addendum to Flight Manual 
Supplement).  Follow instructions under Forwarding a Task to perform this function. 
 
After the task is forwarded successfully, the ACO has the Form 337 and the attachment for 
coordination. The ACO POC double-clicks the work task to open the Form 337 and 
downloads the attachment to a preferred location (computer or network server).  The ACO 
can then convert and sign the document using Acrobat Professional.  (See Signing and 
Certifying Approved Documents) 
 
Once the ACO reviews and/or approves the attachments, the ACO will attach the file and 
return the Form 337 back to the ASI or DAR by clicking the Forwarding icon for the task. 
(For approving documents see Signing and Certifying Approved Documents) 
 
NOTE:  The ACO must forward the task with the approved and signed PDF back to the ASI 
or DAR.  The Complete button on the bottom of the screen should NOT be used for this 
action. 
 
Once the ASI or DAR has the reviewed and approved attachments, he/she can complete 
and sign block 3 and submit the approved Form 337 and attachments back to the Initiator of 
the form. 

When received, the Initiator will need to download a copy of the signed PDF for the aircraft 
owner records and an additional copy for his/her own records. The original 'unsigned' 
document previously attached to the Form 337 will then need to be deleted. 

 

Related Topic: 

Following a Task 

   

Emailing Form 337 Attachments 

This help topic demonstrates the Emailing function. 
  

1. The ASI or an authorized DAR can detach documents from the Attachment tab of the 

electronic Form 337 by clicking the Save icon  and saving the attachment to the 
location desired. 
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2. The ASI or DAR then attaches the saved file to an email and sends it to the ACO for 
coordination.  Once the concurrence is made, the ACO POC converts and digitally 
signs the approved PDF.  (See Signing and Certifying Approved Documents). 
  

3. The ACO then emails the signed PDF back to the ASI or DAR.  
  

4. The ASI or DAR attaches the signed PDF to the Form 337 Workflow (per the 
instructions under File Attachments) and submits the form back to the Initiator.  
  

When received, the Initiator will need to download a copy of the signed PDF for the aircraft 
owner records and an additional copy for his/her own records. The original 'unsigned' 
document previously attached to the Form 337 will then need to be deleted. 
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5.4.6 Using the System as an ASI 

5.4.6.1 Using the System as an Aviation Safety Inspector 

 

The ASI (Aviation Safety Inspector) will review the entire form. If the ASI approves the form, 
the inspector will digitally sign Block 3 and click the Approve button on the bottom right 
corner of the window.  If the ASI rejects the form, the inspector should include a note (see 
Adding Notes) to enter instructions back to the Initiator, and click the Reject button on the 
bottom of the window.  In both cases, the form will automatically be submitted back to the 
Initiator. This section includes data integrity validations to ensure that block 3 is completed 
appropriately if approved or is cleared if rejected. 

 
 
Related Topics: 

Signing and Certifying Approved Documents 

ASI and ACO Coordination 

Field Approval 

Signing Block 3 

Approve/Reject Form 

   

Block 3 

For FAA Use Only 

 

ASI sign-off (left side of form) 

Aviation Safety Inspectors will click on the drop-down box to select the sign-off statement 
appropriate to the type of data approval being granted, click on the Inspector Signature 
field, and then add their Digital Signature to the document. 
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5.4.6.2 Field Approval 

Aviation Safety Inspector - Field Approval 

As an Aviation Safety Inspector with Field Approval authority, you will receive emails as 
shown in the example below to notify you that you have a new work task. 

 

NOTE:  The task number in the email Subject line is related to the software login of the 
instances of the form as it flows through the Workflow.  This number can be referenced for 
troubleshooting purposes.   

 

1. The email text includes information on who sent you the Form 337 for approval along 
with the Tracking number.  The Tracking number is a unique, sequential number 
assigned to each Form 337 once it is submitted.  This number is related to the complete 
Form 337 package and is automatically entered in the upper right corner of the form. 

 

 
  

2. Click the link in the email text or log into the eForm Service site - - 
  https://eformservice.faa.gov/eform337.aspx  

3. Follow the login instructions under Login as FAA Personnel to access the eForm 
Service System. 

4. The form that is waiting for approval will appear on your "Worklist" page. Double-click 
on the form to open it and refer to Approving/Rejecting a Form and Signing Block 3 as 
an ASI for further instructions. 

http://eformservice.faa.gov/eform337.aspx
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5.4.6.3 Signing Block 3 as an ASI 

Block 3 of the Form 337 has the appropriate canned test for Data or Physical Identification 
as well as for Overweight Flight Permit. If approving the form, select the one that applies. 
(To enter comments for the form initiator, click the Attachments tab and select Note, 
following instructions under Adding Notes.) 

1. From the drop-down box on the left side of Block 3, select the sign-off statement 
appropriate to the type of data approval being granted. Then, click on the Inspector 
Signature field. 

 

 
 

NOTE:  You must select a sign-off statement from the drop-down box in order to sign 
the form. 
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2. After clicking the signature field, the Sign Document window appears. Select your 
Digital ID, and click the Sign button. 

 

  
 
  

3. Enter your password when prompted. The digital certificate appears in block 3 as 
shown in the example below. 
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NOTE 1:  If you signed the form with a signature that was not issued by the TATI Certificate 
Authority (i.e., using a personal signature created in Adobe Acrobat), the form will be 
returned to your Worklist page with the following statement under the Instructions column 
as shown in the example below. Obtain a valid signature by following instructions under 
Requesting Digital Certificate and Installing Digital Certificate. 

 
 

NOTE 2:  After installing a valid signature, open the form, right-click on the invalid 
signature, select Clear Signature, and sign the form using the valid signature form the 
TATI Certificate Authority. 

 

 

5.4.6.4 Adding Attachments 

If adding attachments is necessary, please refer to File Attachments. 

 

Related Topics: 

ASI and ACO Coordination 

Signing and Certifying Approved Documents 

 

5.4.6.5 Approving/Rejecting a Form 

The Approve and Reject buttons are located on the bottom right corner of the Form 337 
user interface.  
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1. If approving the form, click the Approve button at the bottom of the window. 

2. If rejecting the form: 

c. Go to Attachments tab and enter a note or comment to describe what needs to be 
changed (see Adding Notes help topic instructions). 

 
 

d. Go back to the Form tab and click the Reject button at the bottom of window. 

NOTE:  There is data integrity based on approval or reject selection.  If approved, 
statement and signature are required in Block 3.  If rejected, statement and signature in 
Block 3 will be cleared. 
  

3. After selecting either Approve or Reject, a "Processing..." message appears and the 
form is sent back to the form initiator. You will be directed back to the Worklist page. 
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4. If finished, click Logout in the upper right corner of the interface.  

 

 
 
  

5. A confirmation window will appear; click OK to log out or Cancel to return to Form 
Manager. 
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5.4.7 FAA Form 337 Reports 

5.4.7.1 Generating Reports 

IMPORTANT NOTE:  Generating reports applies only to Aviation Safety Inspectors and 
Flight Standards management. 

 

1. Log in following instructions under Login as FAA Personnel. 

2. In Form Manager, click on the eForms Admin link on the top menu bar. 

 
 

3. The following eForm Service page opens as a separate window. Click the eForm 
Service Reports link in the left section of the page.  
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4. In the Reports Menu, select the report you would like to generate. 
 

  
 

5. Depending on the report you select, enter any of the search criteria options and click 
Submit.  You can narrow your search by entering additional search criteria. 
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6. Below is an example of one of the reports. To view the Form 337 or any of the 
attachments, click the blue link and the attachment will open in a new browser. 

NOTE:  To view the list in ascending or descending order (such as by Tracking 

Number, N-Number, etc), click on the up-down arrows to the right of the 
corresponding column heading to rearrange the view as desired. 
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5.4.7.2 Report Viewer Toolbar 

 

The Report Viewer Toolbar will assist you with paging, viewing, exporting, and printing the 
report if necessary. 
 

 
 

1. The section below will assist you with paging through the reports. 
 

 
  

2. The next section let's you adjust the size of the report for your viewing preference. 

 

 
 

3.  Export allows you to export the report results to various formats. 

 

 
 

XML file with report data:  This will collect the data into XML (Extensible Markup 
Language) format and you will have the opportunity to save it in this format if deemed 
necessary. 
 
CSV (comma delimited):  This will export data into CSV (Comma Separated Values) 
format and you will have the opportunity to save the report in this format if deemed 
necessary. 
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TIFF file:  This will export the data into a TIFF (Tagged Image File Format) and you will 
have the opportunity to save the report in this format if deemed necessary. 
 
Acrobat (PDF) file:  This will render the report into PDF (Portable Document Format). 
 
Web archive:  This will render the report into web format. 
 
Excel:  This will render the report to a Microsoft Excel spreadsheet. 
 
NOTE:  When exporting the report, you will not be able to open the PDF 337 Forms or the 
attachments. If you attempt to click on a link in an exported report, the following message 
may occur:  (Click No to close the error message) 
 

 
 

4.  The Refresh button will enable you to refresh the reports data to view the most current 
set of data. 
 

 
 

5. The Print button will let you print the current report in the Viewer. 
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5.5 Industry Users 

5.5.1 System Login 

5.5.1.1 Login as Industry User 

To enter the eForm system as an Industry User, follow the login procedures below. 

1. Access the http://eformservice.faa.gov/eform337.aspx web site. 

2. Under AVS Form Manager Access on the right side of the home page, click on the Log 
Into eForm Service link.  

 
 
  

http://eformservice.faa.gov/eform337.aspx
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3. A Warning page appears as shown below. To proceed to the eForm Service login page, 
click on the I Agree to these terms button. 
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4. In the eForm Service Access page, enter your user name that was supplied to you 
when you created your eForm Service Account, and then enter your password. Then, 
click the Login button to access the eForms Service System. 

 

 
 

NOTE:  After three attempts of entering the wrong login information, the system will 
log you out. The following message appears, instructing you to close the browser, 
re-open it, and re-navigate back to the Login page. 

 

 
  

5. Industry users who perform work for certificated organizations will be presented with an 
Account Login Selector screen. For example, an individual with an IA may perform work 
not related to a certificated organization. In this case, the individual has the option to 
log in as himself/herself to initiate a form on an aircraft or log in as an employee of a 
certificated organization if that organization is performing the major repair or alteration. 
See the next Help Topic on Account Login Selector for further details. 
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6. After successful login, the Form Manager page is displayed and the login name 
appears in the upper right corner of the page. 

 
 

5.5.1.2 Account Login Selector 

1. Industry users who also work for certificated organizations (i.e. repair stations) will see 
the following screen after logging in with their individual user account. 
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2. Select your user account from the drop-down box. 

 

 
NOTE: Check the "Remember Selection" check box if you wish to use this selection as the 
default login for future access without returning to this selector page. To turn off the default 
login, follow the steps in the next section below.   

3. After choosing the Login option from the drop-down list, click the Select button to enter 
the FAA eForm Service Form Manager page. To verify the login name, check the upper 
right corner of the browser screen. 
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To Turn Off the Default Login 

1. To turn off the default login, simply select the "MyProfile" check box in the main Login 
page the next time you access the system. 

 
  

2. Uncheck the "Remember Selection" check box on the Default Login Information page, 
and then click the Continue button.  See example below.  
 
NOTE: The next time you log in, you will be directed to the Account Login Selector 
page. 
 
For additional information, see Help Topic Selecting and Changing the Default. 
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Related Topic: 

Editing Individual Account Profile 

 

5.5.1.3 Editing Individual Account Profile 

This Help Topic provides details on how to edit information in your individual account 
profile. 

1. Log in as usual and select the "MyProfile" box before clicking the Login button. 
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2. The MyProfile page will appear as shown below. 

 
 

3. Edit as necessary for email and address changes. Email address is required and used 
for email notification during the Form 337 routing process. Address information is 
optional. Contact the local FSDO for changes to your certificate and/or rating so they 
can request an update to your Form 337 login account. Allow up to 72 business hours 
for changes. Click the Continue button when done. 

4. A confirmation page will be shown next if you made any changes. You will automatically 
be sent to the profile page to confirm your changes the next time you access the 
system. Review the confirmation page and then click the "...Continue" link. 
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5.5.2 Obtaining User Accounts 

5.5.2.1 Individual Accounts 

 

IMPORTANT NOTE:  This process applies only to individuals who are not employed by any 
certificated organization. 

Follow the two required processes below to initiate the account request to access and use 
the electronic FAA Form 337: 

1. Register as a user with the AVS eForm Service - - Contact the local Flight Standards 
District Office (FSDO) to schedule an appointment with your FAA AVS field office Point 
of Contact (POC), who will initiate the account request. You will need to present current 
FAA-issued certifications to prove that you have the valid credentials required to access 
the system. Also contact the local FSDO for changes to your certificate and/or rating so 
they can request an update to your account. 

2. Obtain a Digital Certificate to be used as your electronic Signature on the Form 337 - - 
Request a Digital Certificate from the authorized and approved Certificate Authority, 
TeamAskin.com. This is a third party site and is not managed by the FAA. The link to 
that web site is found in http://eformservice.faa.gov/ReDir.aspx?u=askin.  

 

NOTE:  Requesting a user account can be done before or after your request for a 
digital certificate.   

 

Local FSDO Offices 

Click here to view contact information for the nearest FSDO. 

 

 

Related Topic: 

Editing Individual Account Profile 

 

http://eformservice.faa.gov/ReDir.aspx?u=askin
http://www.faa.gov/about/office_org/field_offices/fsdo/
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5.5.2.2 Certificated Organization Accounts 

 

USER ACCOUNT REQUEST FOR CERTIFICATED ORGANIZATIONS 

 

IMPORTANT NOTE:  This process applies only to individuals who are also employed by 
any certificated organization(s).  Follow the same process for changes (additions or 
removals). Repair Stations or Maintenance Organizations with several Industry Users need 
to follow the steps below. 

 

1. Access the http://eformservice.faa.gov/eform337.aspx web site. 

2. Click the Certificated Organization User Account Request link at the bottom left of 
the web page. 
 

 
 
  

http://eformservice.faa.gov/eform337.aspx
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3. You are directed to the 'Certificated Organization User Account Request' page. Read 
the directions on this page before continuing to the next step. 

 
 
  

4. Click the Certificated Organization User Account Request Spreadsheet link. 

5. Download the spreadsheet and complete, at a minimum, all of the required (Red) 
columns appropriately (Please ensure accurate contact information (phone/email) in 
case there are questions about the user request). Once completed, please email the list 
to your local FAA certificate holding field office Point of Contact (PMI or PAI, etc.) for 
approval and validation. Follow the same procedure for changes (additions or 
removals) for your organizations. 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
106 

 
 
  

6. The local FAA personnel POC will review and verify all the information provided and 
forward the spreadsheet with a statement requesting the creation of these accounts to 
their local computer specialist, who will forward the request to the AVS National Service 
Desk. Protocol dictates that the Service Desk personnel will only accept requests for 
organizational account requests or changes from the local office computer specialist. 

7. Once received, Service Desk personnel will begin the process of creating the user 
accounts. They will initiate the account(s) and send out automated email notifications 
with instructions. The process is as follows: 

 The new user will receive an email that includes a link to the AVS Provisioning 
Service Portal for user registration along with a temporary password 

 After the user has successfully registered the account, a second email with the 
user login ID will follow.  

 The FAA POC will receive an email confirmation upon completion of the new 
account. 
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5.5.3 Using the System as a Form Initiator 

5.5.3.1 Opening a Form 337 

You can open a new form from the Form Directory Panel on the left side of the Form 
Manager page or the Worklist tab on the right side of the page. 

  

1. To open a new form, double-click “Major Repair/Alteration” (not the star icon) on the 
Form Directory Panel. 

NOTE:  Clicking on the star icon will add/remove the selection to/from the Favorites 
category.  
 

 
  

2. To open an existing form (or task), double-click on the form name in the Worklist. 
Placing the mouse pointer over a task will display detailed information about that task. 

 

NOTE:  Placing the mouse over a forwarded task will also display who forwarded the task. 
A trash icon will not appear to the right of the task, because only the initiator of the form can 
delete the forwarded task. 
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5.5.3.2 Search Button (Block 1) 

The Search button in Block 1 allows you to search for an aircraft's information based on the 
Registration Mark that you enter and automatically fill in the information onto the form for 
you. When using this feature, it is always good practice to verify the aircraft information that 
was automatically filled in for you. 

 

1. Enter the Registration Mark to the right of the 'N'. 
 

 
  

2. Click the Search button.  

3. The first time you perform a search, you may receive the following Security Warning. 
Select the "Remember my action…" check box and click the Allow button. 
 

 

 
NOTE:  This selection lets the application know that you trust this site for database 
searches and web service functionality to fill in the form.  
 
NOTE:  If another window appears other than the Security Warning window above, refer to 
Data Connection Security Warning in the Troubleshooting section for further instructions. 
 

4. The fields in Block 1 will be auto-filled except for the Serial No.  Verify the Serial No. 
and enter it manually (this is an additional method of validation and will validate upon 
submitting the form).  You can edit any of these fields to reflect a bill of sale, a change 
in the Make or Model, the change to include the Series, etc.  This information is saved 
to the Form 337 database. 
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NOTE:  If the validation fails, check your N number and Serial No. entries in block 1.  If 
it still fails, it may be a result of the change request to Registry not being accomplished 
at the time of submission of the 337.  Save the form to your Worklist and follow up on 
the change with Registry.  Then open the saved Form 337 and complete the 
submission.    
  

 Related Topic: 

Data Connection Security Warning 

 

5.5.3.3 Adding a New Block 8 

1. Click the Add a New Block button on page 2 of the form (shown below) to create 
additional space (pages) to the 'Description of Work Accomplished' (Block 8). This 
allows you more space to type the description of the work accomplished. 
  

 
 

2. Describe repair or alteration in Block 8; this is a required field to submit the form to the 
next stage (i.e., ASI, DAR or Return to Service agent).  Cut and paste text as necessary 
– remembering the 8,000 character limitation.   

3. Block 8 will expand dynamically based on text entered.  Pages will be created as you 
add text or new text blocks. 

4. If necessary, type the phrase “See attached files”. Then, go to the Attachments tab, 
attach a file that describes the work accomplished, and select "Send to Registry”.  
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5.5.3.4 Working with Attachments 

Files uploaded to this system cannot exceed 8 ½ by 11 or European A4 (Portrait or 
Landscape) or larger than 5MB. For additional information, see File Upload Limitation for 
list of acceptable file types.  Password-protected or restricted documents will not be 
accepted for upload in the Form 337 workflow. Although there are no limits to the number of 
attachments, the more attachments there are in the Workflow, the longer it will take to 
submit or retrieve the Form 337. 

Refer to the following instructions when working with attachments in Form Manager: 

File Attachments (General Information) 

Adding a File Attachment 

Saving an Attachment 

Updating an Attachment 

Deleting an Attachment 

5.5.3.5 Component Repair 

With Blocks 1 and 2 empty, complete Blocks 4, 5, 6 and 8 for a component repair.  Upon 
approval, the Return to Service Agent will confirm if the repair or alteration is for a 
component.  The Form 337 will be held indefinitely until it is installed. The form can then be 
retrieved by following the steps below. 

NOTE:  Completion of Blocks 1 and 2 are required upon component installation and prior to 
final form submission to Registry. 

1. Double-click Major Repair/Alteration Component Search (not the star icon) on the 
Form Manager Directory Panel. 

NOTE: Clicking on the star icon will only add or remove the selection from the Favorites 
category. 
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2. The 337 Component Search window appears.  Enter the Tracking Number, click 
Validate, and follow instructions provided in the Step 2 window. 
 

 
 

 

Related Topics: 

 

Installing a Component 
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5.5.3.6 Complete Button and Routing Information 

1. When the form is ready for submission to either the ASI, a DAR, or for approval for 
Return to Service, click the Complete button in the lower right corner of the page.  
 

 
 
 

2.  The Routing Information window will appear (see example below). This will route the 
Form 337 to the next step in the workflow process. 
 
NOTE:  Ignore the "Warning: JavaScript Window" on the bottom of the window.   
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3. Select the appropriate approval type and person you want approval from. 

a. Select Type of Approval or Review 

Clicking on the drop-down box under 'Select a Type of Approval or Review' will list the 
three items below: 

 Aviation Safety Inspector 

 Designee 

 Return to Service Agent 

 

Select the appropriate approval or review type that you need for your Workflow 
Document. 

 If Aviation Safety Inspector review is selected:  Whether approved or rejected, 
the Form 337 will be returned back to Initiator  

 If Designee is chosen for field approval:  Whether approved or rejected, the 
Form 337 will be returned back to the Initiator.  

 If Return to Service Agent is selected for approval:  If rejected, the Form 337 
will be returned to the initiator. If approved, it will go forward for delivery to the 
Aircraft Registry, and the Initiator will receive an email confirmation with the 
attached read-only copy of the signed Form 337. The Return to Service Agent, 
ASI, or DAR receives a courtesy copy of the e337 as appropriate, depending 
on their participation. 
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NOTE:  If the initiator (individual Mechanic with Inspection Authorization or certificated 
person acting on behalf of a Certificated Organization) desires to approve the 
repair/alteration for Return to Service, he/she must select himself/herself or the 
appropriate certificated organization from the drop-down list within the Region/field 
office with oversight of his/her certification.  This is necessary for the form to move to 
the next stage of the workflow. 
  

b. Select FAA Region 

Clicking on the drop-down box under 'Select a FAA Region' lists the different regions an 
FAA center is located.  Select the region where the person you want to approve your 
Workflow document is located. 
  

c. Select FAA Office 

Clicking on the drop-down box under the 'Select a FAA Office' lists the different offices 
in the FAA that corresponds with the region you selected.  Select the Office where the 
person you want to approve your Workflow form is located. 

 

d. Click the Search button 

 
Note: Wait about 5-10 seconds and the list should be generated. 

 

e. Select a person to approve/review this modification 

Clicking on the drop-down box under 'Select a person to approve/review this 
modification' will display a list of names that can approve/review your Workflow form. 
  

4. Click the OK button when you are finished filling out the Routing Information.  The 
information you entered will be saved automatically. 

5. A “Processing…” message will appear at the bottom of the first page of the form.  
 

 
 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
115 

NOTE 1:  If you signed the form with a signature that was not issued by the TATI Certificate 
Authority (i.e., using a personal signature created in Adobe Acrobat), the form will be 
returned to your Worklist page with the following statement under the Instructions column 
as shown in the example below. Obtain a valid signature by following instructions under 
Requesting Digital Certificate and Installing Digital Certificate. 

 
 

NOTE 2:  After installing a valid signature, open the form, right-click on the invalid 
signature, select Clear Signature, and sign the form using the valid signature form the 
TATI Certificate Authority. Click the Complete button when ready. 

  

6. The Status of the form will be displayed in the In Progress tab. Each item can be 
identified by the unique Process ID.   
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NOTE:  The Form 337 will be sent to the user selected, along with an email notification. 

 

7. When finished, close the system by clicking Logout in the upper right corner of the 
Form Manager window. Make sure process is completed before clicking the Logout 
button. 

 
 
 

8. A confirmation window will appear; click OK to log out or Cancel to return to Form 
Manager. 
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5.5.3.7 Forwarding Task 

The Forward function can be used to forward a task to another for review purposes, 
collaboration, or assistance in completing block description in Block 8 by an administrative 
person. This does not submit the form or route it to the next stage in the workflow process. 

 

WARNING! Certificated organization should NOT use the forwarding task unless 
forwarding to an individual outside the organization. Instead, users completing work for a 

certificated organization only need to click the Save to Worklist (Draft) button  
when they have finished working on a specific form. Others in the organization can identify 
tasks assigned by the organization using the unique process ID.  
 
  

See Forwarding a Task for further instructions. 

See Complete Button and Routing Information to submit and route the form to the ASI, 
DAR, or RTS agent. 
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5.5.4 Using the System as an RTS Agent 

5.5.4.1 Form Field Information 

The system includes Data Integrity which requires the completion of certain fields or blocks 
within the form based on the steps within the Form 337 submission process.  Error 
Messages will appear if required fields are not completed. 

 

Return to Service Agent 

The Return to Service Agent will receive an email notification from the Workflow "admin" 
that a new workflow item requires action. 

 

The RTS (Return to Service) Agent reviews data entered in Block 8 and fills out Block 7. 

 

If the RTS Agent rejects the form, the agent makes the necessary comments on the cover 
page and clicks the Complete button to resubmit the form back to the Initiator. 

 

If the RTS Agent approves the form, the agent will complete and digitally sign Block 7 and 
click the Complete button to send the form to Registry. 

 

Block 7 

Approval for Return to Service 

 

Approval for Return to Service 

Approved/Rejected:  Check the ”Approved” or “Rejected” box to indicate the finding. 

 

By 

Check the appropriate box to the left of the name to indicate who made the finding. 

 

Other   

Use this block to indicate a finding by a person other than those listed. 
  

Certificate or Designation No. 

Enter the appropriate certificate or designation number. 
  

Signature of Authorized Individual 

Click inside the Signature box to apply your Digital signature for the approval of Return to 
Service. 
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5.5.4.2 Opening and Reviewing the Form 337 

 

1. From the "Worklist” tab on the Form Manager, double-click on a Form 337 submitted for 
approval to Return to Service. Each task can be identified by the unique Process ID. 
 
NOTE:  Placing the mouse pointer over a task will display detailed information about 
that task. 

 

  
 

2.    Review the Form 337 submission. 

NOTE:  Take special care to make sure the Registration and Nationality Mark and the 
Serial Number are accurate.  A validation check will occur on submit if approved (see 
Validation Checks). 
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5.5.4.3 Add/Remove Interim Inspection and Signature Block 

 

The RTS Agent can add/remove the interim inspection and signature block. 

 

Add Signature Block 

Clicking on the button labeled Add Interim Inspection and Signature Block (block 8) will add 
the signature block underneath the button. 

 

Remove Signature Block 

Clicking on the button labeled Remove Interim Inspection and Signature Block (block 8) will 
remove the signature block underneath the button. 
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5.5.4.4 Reject for Return to Service 

 

If rejected for Return to Service, enter notes or comments and send the form back to the 
Initiator as follows: 
  

1. Click the Attachments tab and select Note.  Enter your notes or comments for the 
recipient of the form as necessary and click OK. (See Adding Notes for further details.) 
 

  

2. Select the Rejected checkbox in Block 7. 
 

 
  

3. Click the Complete button at the bottom right corner of the window.  The Form 337 will 
automatically be sent back to the Initiator with your comments on what needs to be 
corrected. 
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4. A “Processing…” message will appear at the bottom of the first page of the form. The 
form is then sent back to the Initiator. 
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5.5.4.5 Approve for Return to Service 

 

If approving the Form 337, complete and sign Block 7 as follows: 

1. Select the Approved checkbox, complete Block 7, and click in the signature/date field. 
 

 
 
  

2. The "Sign Document" window appears. Select your digital ID from the dropdown box, 
and click the Sign button. 
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3. Enter your digital certificate password and click OK. Your digital certificate is applied to 
the signature field.  
 

 
 
  

4. Click the Complete button. The Form 337 as approved for Return to Service will 
automatically be forwarded to Registry. A “Processing…” message will appear at the 
bottom of the first page of the form. 
 

 
 
 
  



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
125 

5.5.4.6 Validation Checks 

 

1. Upon clicking the Complete button, the following validation checks are performed. One 
checks if the Form 337 is for a Component Repair, another verifies that the Aircraft 
Registration (N) Number and Serial Number match what is in the Aircraft Records, and 
another checks whether the signature is valid or not. Base on the results of these 
validation checks, the following messages will appear.  
  

a. If the Form 337 is approved for Return to Service and is for a component repair 
(Block 1's Registration N Number and Serial Number are empty) the Return to 
Service agent will receive the following confirmation prompt, asking if it is for a 
component repair.  Click Yes if it is for a component repair. (If it is not for a 
component repair – click No.  The form will not submit and you will be instructed to 
return the Form to the initiator to correct Block 1.) 
 

 
 

NOTE:  As a component repair, it will be held indefinitely until the component is installed. 
 See the Online Help topic, “Installing a Component”. 
 

b.  If the Form 337 does not match the Aircraft Registry Registration N Number and 
Serial Number combination, an error message will appear at this time to verify and 
correct the information.  Click OK.  The form will not submit.  Please reject the form 
for verification. 

 
  

c. If you signed the form with a signature that was not issued by the TATI Certificate 
Authority (i.e., using a personal signature created in Adobe Acrobat), the form will 
be returned to your Worklist page with the following statement under the 
Instructions column as shown in the example below. Obtain a valid signature by 
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following instructions under Requesting Digital Certificate and Installing Digital 
Certificate. 

 
 

NOTE:  After installing a valid signature, open the form, right-click on the invalid signature, 
select Clear Signature, and sign the form using the valid signature form the TATI 
Certificate Authority. 

 

2. The completed record is stored in the Return to Service Agent’s Archive for 365 days, 
where you can print a copy and download attachments, if desired. 
  

3. An email will be sent to the Initiator and a courtesy copy to the RTS agent, confirming 
receipt by the FAA. 
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5.5.4.7 Email Notifications 

 
Each time someone sends a Form 337 for action, the recipient selected in the Routing dialog will receive an 
email notification of that work task. 
 

Example: 

 
 
  

4. Additionally, an email notice of the final Form 337 Submittal will be sent to the Initiator 
with a courtesy copy to the Return to Service (RTS) Agent of receipt of the Form 337 by 
the FAA. 

 

Example: 
 

 

 
  

5. Be aware of email limitations (attachment size, mailbox size) and that the final Form 
337 notifications with PDF attachment could be 2MB or more. 
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5.5.5 Using the System as a Designee 

Designee or DAR (Designated Airworthiness Representative) 

The Designee will review the entire form. If the Designee approves the form, he/she will 
digitally sign Block 3 and click the Approve button on the bottom right corner of the 
window.  If the Designee rejects the form, he/she should include a note (see Adding 
Notes) to enter instructions back to the Initiator, and click the Reject button on the 
bottom of the window.  In both cases, the form will automatically be submitted back to 
the Initiator. This section includes data integrity validations to ensure that block 3 is 
completed appropriately if approved or is cleared if rejected. 

 
Related Topics: 

Signing and Certifying Approved Documents 

DAR and ACO Coordination 

Signing Block 3 as a Designee 

Approving/Rejecting a Form 

   

Block 3 

 

DAR 50 or DAR 51 sign-off (right side of form) 

Designees who are certifying the data on the form will select the appropriate sign-off 
statement from the drop-down box, add their Authorization Number, click on the 
Designee Signature line, and then add their Digital Signature to the document. 
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5.5.5.1 Signing Block 3 as a Designee 

If approving the Form 337, follow the instructions below for signing the form (To send 
comments to the form initiator click the Attachments tab and select Note, following 
instructions under Adding Notes.) 

1. From the drop-down box on the right side of Block 3, select the appropriate sign-off 
statement, add your Authorization Number, and click on the Designee Signature field. 

 
 

NOTE:  You must select either Designee 50 or Designee 51 in order to sign the form. 
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2. After clicking the signature field, the Sign Document window appears. Select your 
Digital ID, and click the Sign button. 

 
 

3. Enter your password when prompted. The digital certificate appears in block 3 as 
shown in the example below. 
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NOTE 1:  If you signed the form with a signature that was not issued by the TATI Certificate 
Authority (i.e., using a personal signature created in Adobe Acrobat), the form will be 
returned to your Worklist page with the following statement under the Instructions column 
as shown in the example below. Obtain a valid signature by following instructions under 
Requesting Digital Certificate and Installing Digital Certificate. 

 
 

NOTE 2:  After installing a valid signature, open the form, right-click on the invalid 
signature, select Clear Signature, and sign the form using the valid signature form the 
TATI Certificate Authority. 

 

5.5.5.2 Approving/Rejecting a Form 

The Approve and Reject buttons are located on the bottom right corner of the Form 337 
user interface. 

   
  

1. If approving the form, click the Approve button at the bottom of the window. 

2. If rejecting the form: 

a. Go to Attachments tab and enter a note or comment to describe what needs to be 
changed (see Adding Notes for instructions). 
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b. Go back to the Form tab and click the Reject button at the bottom of window. 

NOTE:  There is data integrity based on approval or reject selection.  If approved, 
statement and signature are required in Block 3.  If rejected, statement and signature in 
Block 3 will be cleared. 
  

3. After selecting either Approve or Reject, a "Processing..." message appears and the 
form is sent back to the form initiator. You will be directed back to the Worklist page. 

 

 
  

4. If finished, click Logout in the upper right corner of the interface.  
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5. A confirmation window will appear; click OK to log out or Cancel to return to Form 
Manager.  

 
 

5.5.5.3 ASI/DAR and ACO Coordination 

In some instances an Aviation Safety Inspector (ASI) or authorized Designee has the need 
to coordinate the review or approval of supplemental or supporting documents included with 
Form 337 submission (see Signing and Certifying Approved Documents). 

 

A supplemental document is a document that provides supplemental information to the ASI 
or DAR in support of the modification but is not considered an attachment to the Form 337. 
Therefore, the document is selected as 'Do Not Send to Registry' (for example, proprietary 
information such as an engineering report). 

  

A supporting document is a document that is essentially part of the Form 337 or an 
extension of Block 8 and supports the description of the work to be accomplished.  At times 
a document may need an approval signature (i.e., an Addendum to a Flight Manual 
Supplement).  This document is one that would be attached with the 'Send to Registry' 
selection and would, therefore, be delivered to Registry along with the Form 337. 

 

After a determination that coordination between the ASI/DAR and ACO is needed, the 
system provides two methods to accommodate the transfer of information.  The preferred 
method is Forwarding the Form 337 file to the ACO point of contact (POC).  The alternate 
method is Emailing the attachment back and forth between the ASI/DAR and the ACO 
POC. 

Signing and Certifying Approved Documents 

1. With the File open in Adobe Professional, select Sign > Certify with Visible Signature 
from the Menu bar. 
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2. The Save as Certified Document dialog appears. Click OK. 
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3. Click OK when prompted to create the signature field. 

 

 
 
  

4. With your mouse, drag and draw the area where you wish to sign. 

 

 
  

 

5. Select your digital signature from the drop-down box and select "No changes allowed" 
for the Permitted Changes... dropdown box. Then, click the Sign button. 
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6. The Save As dialog box appears. Select the appropriate folder, save document using 
the same file name, and click the Save button. 
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7. Enter your digital certificate password and click OK. 

 
  

8. Your digital certificate is applied to the signature field. 

 

 
  

9. If the approved document is signed by the ACO POC, they must return the certified and 
signed PDF document to the ASI or authorized DAR by the same method it was 
received (i.e. Forwarding or Emailing). The ASI or authorized DAR can then attach the 
document to the Form 337. 
 
NOTE:  Do not password-protect the certified/signed PDF document.  It is not 
necessary and will cause problems when the document is eventually processed for 
delivery to Aircraft Registry. 
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Forwarding Form 337 

 

The ASI or an authorized DAR can forward the Form 337 task to their ACO POC to 
complete the approval process of the attached document (i.e. Addendum to Flight Manual 
Supplement).  Follow instructions under Forwarding a Task to perform this function. 
 
After the task is forwarded successfully, the ACO has the Form 337 and the attachment for 
coordination. The ACO POC double-clicks the work task to open the Form 337 and 
downloads the attachment to a preferred location (computer or network server).  The ACO 
can then convert and sign the document using Acrobat Professional.  (See Signing and 
Certifying Approved Documents) 
 
Once the ACO reviews and/or approves the attachments, the ACO will attach the file and 
return the Form 337 back to the ASI or DAR by clicking the Forwarding icon for the task. 
(For approving documents see Signing and Certifying Approved Documents) 
 
NOTE:  The ACO must forward the task with the approved and signed PDF back to the ASI 
or DAR.  The Complete button on the bottom of the screen should NOT be used for this 
action. 
 
Once the ASI or DAR has the reviewed and approved attachments, he/she can complete 
and sign block 3 and submit the approved Form 337 and attachments back to the Initiator of 
the form. 

When received, the Initiator will need to download a copy of the signed PDF for the aircraft 
owner records and an additional copy for his/her own records. The original 'unsigned' 
document previously attached to the Form 337 will then need to be deleted. 

 

Related Topic: 

Following a Task 
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Emailing Form 337 Attachments 

This help topic demonstrates the Emailing function. 
  

1. The ASI or an authorized DAR can detach documents from the Attachment tab of the 

electronic Form 337 by clicking the Save icon  and saving the attachment to the 
location desired. 

 

 
  

2. The ASI or DAR then attaches the saved file to an email and sends it to the ACO for 
coordination.  Once the concurrence is made, the ACO POC converts and digitally 
signs the approved PDF.  (See Signing and Certifying Approved Documents). 
  

3. The ACO then emails the signed PDF back to the ASI or DAR.  
  

4. The ASI or DAR attaches the signed PDF to the Form 337 Workflow (per the 
instructions under File Attachments) and submits the form back to the Initiator.  

 
When received, the Initiator will need to download a copy of the signed PDF for the aircraft 
owner records and an additional copy for his/her own records. The original 'unsigned' 
document previously attached to the Form 337 will then need to be deleted. 
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5.5.6 

5.5.6.1 Installing a Component 

 

plete Blocks 1 and 2 on the Form 337 and submit it to 

 

ck Major Repair/Alteration Component Search (not the star icon) on the 
Form Manager Directory Panel. 
 
NOTE: Clicking on the star icon will only add/remove the selection to/from the Favorites 
category. 
 

Completing Form 337 as an Installer of a Component 

To install a component, you must com
Aircraft Registry. 

1. Double-cli

 
 
  

2. The 337 Component Search window appears.  Enter the Tracking Number, click 
Validate, and follow instructions provided in the Step 2 box. 
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3. Blocks 1 and 2 are required fields and must be completed before clicking the Complete 
button on the bottom of the window. 
 

 
  

4. Place the cursor in the middle of the Nationality and Registration mark field to the right 
of the “N” and type in the aircraft number.  Then click Search. 
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5. The first time you perform a search, you may receive the following Security Warning. 
Select the Remember my action… checkbox and click the Allow button. 

 

 

 
NOTE:  This selection lets the application know that you trust this site for database 
searches and web service functionality to fill in the form. 
 
NOTE:  If another window appears other than the Security Warning window above, refer to 
Data Connection Security Warning in the Troubleshooting section for further instructions. 
  

6. The fields in Block 1 will be auto-filled except for the Serial No.  Verify and enter the 
Serial No. manually (this is an additional method of validation and will validate upon 
submitting the form).  You can edit any of these fields to reflect a bill of sale, a change 
in the Make or Model, the change to include the Series, etc.  This information is saved 
to the Form 337 database. 
 
NOTE:  If the validation fails, check your N number and Serial No. entries in block 1.  If 
it still fails, it may be a result of the change request to Registry not being accomplished 
at the time of submission of the 337.  Save the form to your Worklist and follow up on 
the change with Registry.  Then open the saved Form 337 and complete the 
submission.    

7. Click the Complete button on the bottom of the window to send the completed Form 
337 of the installed component to Registry. 
  

 
 
 
Related Topic: 
  

Data Connection Security Warning 
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5.5.7 Certificated Organization Users 

5.5.7.1 Selecting and Changing the Default 

Industry users who perform work for certificated organizations will be presented with an 
Account Login Selector screen. For example, an individual with an IA may perform work not 
related to a certificated organization. In this case, the individual has the option to log in as 
himself/herself to initiate a form on an aircraft or log in as an employee of a certificated 
organization if that organization is performing the major repair or alteration. If the user 
selects the "Remember Selection" checkbox, it will become the default for each time the 
user logs in.  

 

 
 
 

Related Topic: 

Account Login Selector 
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5.5.7.2 CertOrg Worklist 

A Worklist for a certificated organization (Repair Stations, Foreign AMO's and 121, 135, 
91K certificate holders with a Continuous Airworthiness Maintenance Program (CAMP)) will 
contain multiple Form 337 tasks being processed by employees of that organization. 
Internal processes established by the organization will determine task assignment and 
control. The items can be identified by the unique Process ID. 

   

 
 

WARNING! Certificated organization must NOT use the forwarding task  unless 
forwarding to an individual outside the organization.  

Instead, users completing work for a certificated organization only need to click the Save to 

Worklist (Draft) button  on the bottom left corner of the window when they have 
finished working on a specific form. Others in the organization can, when assigned, open 
any previously Save to Worklist task. Each item can be identified by the unique Process ID.  
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Once an electronic Form 337 is ready for approval (for example, field approval or approval 
for Return to Service), the user must click the Complete button at the bottom right corner of 
the window to route the form to the appropriate approval type in the routing dialog (shown 
below). In most cases, a certificated organization will route a Form 337 back to that 
organization for approval to Return to Service. Doing this changes the state of the form so 
that Block 7 is opened and can be completed. 
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Related Topic: 

 

Complete Button and Routing Information 
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5.5.8 Deleting Tasks and System Purge 

Deleting Tasks 

 
Displayed tasks can be deleted only by the Initiator. A trash icon appears to the right of 
each task except for forwarded or assigned tasks. This function allows the user to 
manage and clean out their Worklist.  

 

NOTE:  The Delete function is irreversible. This is not the same as a purge done by the 
system. 
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System Purge 

 
The system will automatically purge Form 337 tasks that have not been completed 
within one year of the last modified date. This does not include Form 337 Component 
Repairs that have been approved for Return to Service. 

A warning email message will be automatically sent 30 days before the record is 
purged. See example of email below. 

 

EXAMPLE:  

 

From: 9-AMC-AVS-Workflow-Admin@faa.gov  

 

Subject:   WARNING: Termination of inactive e337 record in 30 days  

 

This is to notify you that your Form 337 with Process Task ID <unique number> 
will be terminated in 30 days. You do not need to do anything if the repair or 
alteration is no longer valid or needed for future completion. It will be purged 
from the system automatically in 30 days. However, if you wish to keep this as an 
active and valid record, simply update the record by performing the following:  

 

1. Double-click the record in Worklist to open the form.  

2. Click the Save to Worklist (Draft) icon in the lower left corner of the form view 
window. (Or, for those records initiated prior to the November 2008 system 
changes, click the blue Save to Draft button located in the upper right corner of 
page one of the form)  

3. Close the form by clicking the small x at the top right of the "light gray form view 
window".  

4. Validate that the Updated Date entry in the Worklist has been changed to the 
current date. (Refresh the browser, if necessary.)  

5. The record will safely remain in your Worklist for another year. If at that time it has 
not been updated or completed, another system warning email will be sent 30 days 
before it is purged.  

 

THIS IS AN OUTBOUND EMAIL ADDRESS ONLY.  PLEASE DO NOT REPLY TO 
THIS MESSAGE.  
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5.6 Troubleshooting 

5.6.1 Data Connection Security Warning 
 

When filling out Block 1 and clicking the Search button, a Security Warning dialog box may appear 
as shown below.  

 

 
  

 

 
 
 
 

If you select the "Remember my action..." checkbox and then mistakenly click on the Block 
button, Adobe Acrobat will not allow you to proceed with filling out the form. The two dialog boxes 
below will appear. 
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Click OK for both boxes and perform the following steps: 

 

1. Open Acrobat Reader. 

2. Click Edit > Preferences. 
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3. The Preferences window appears. Select Trust Manager under Categories on the left side 
of the window and click the Change Settings button. 
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4. The Manage Internet Access window appears. Highlight the URL name, as shown in the 
example below, and click the Delete button. 
 

 

 
NOTE:  Anytime you open a protected PDF document and a security warning dialog box 
prompts you to allow or block a URL, select the "Remember my action for this site" check 
box to add the URL to the "My Web Sites" list/text box above. 
  

5. Click the OK button when done and close Adobe Reader.  
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5.6.2 Attachment Dimensions 
 

1. Only 8 ½ by 11 or European A4 (Portrait or Landscape), or smaller, will be accepted by Aircraft 
Registry.  If a file is greater than this dimension, the upload will fail and a message will appear 
for the user to resize the document and try the upload again. 

2. Each file attachment must be 5MB or less. 
 
NOTE:  The more attachments added to the Workflow, the longer it will take to submit or 
retrieve the Form 337. 

 
 

5.6.3 File Types 
 

1. Only the following file types can be attached in the Form 337 workflow. 
 
Microsoft Office Word Document (specifically .doc and .docx) 

Adobe PDF file (specifically .pdf) 

Plain Text file (specifically .txt) 

Rich Text file (specifically .rtf) 

Image files (specifically .jpg, .jpeg, .gif, .tiff, .tif, or .eps) 

Microsoft Bitmap image files (specifically .bmp) 

Microsoft Visio (specifically .vsd) 

Microsoft Office Excel Spreadsheet (specifically .xls and .xlsx) 

Microsoft Office PowerPoint Presentation (specifically .ppt and .pptx) 

PostScript Print files (specifically .ps) 

AutoCAD (specifically .dwg) 
 

2. Password-protected or restricted documents will not be accepted for upload in the Form 337 
workflow. A time-out message will appear after a period of time with instructions to verify 
whether the file is password-protected or restricted. The user needs to remove the password or 
restriction and try to upload again. The system converts “Send to Registry” attachments to TIFF 
before being submitted to the Aircraft Registry.  Some attachments may be restricted PDF files 
or read-only .doc or .rtf documents. This will prevent the conversion to TIFF for integration with 
the Registry EDRS program. 
 
 
  

 
 



Form 337 User Guide   Revision:    7.0 
   Date: 2/29/12

 

UNCONTROLLED COPY 
154 

5.6.4 Configuration Conflicts 
 

NOTE: AVS Configuration Management team tests and controls all AVS client configuration as well 
as baseline software version update. The software versions for the following products are required 
for this system and are currently part of the AVS standard client. 

 
Adobe Reader and Adobe Acrobat Professional 

 
The eForm Service has been tested and validated to work with Adobe Reader and Acrobat 
Professional version 9.1.1 (or later). Additionally, the program requires Adobe Flash Player 
v10.0.22.87 (or later). For instructions on how to install the correct version, see Adobe Reader 
download web page. 

 
 

Adobe Flash Player 

 

The AVS eForm Service has been tested to work with Adobe Flash Player v10.0.22.87 (or 
later). Earlier versions do not support current system functionality. 

 

 

Related Topic: 

System Requirements 

http://eformservice.faa.gov/downloadreader.aspx
http://eformservice.faa.gov/downloadreader.aspx
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5.6.5 Frequently Asked Questions 
 

Q:  When I open the form it is Read Only and I cannot complete the task. 

A:  Check to see if you are opening the form from the In Progress or Archived tab.  In most cases, 
this is the cause.  

 

Q:  When I look at the form in Archive(d) it does not show the completed form. 

A:  The Archive(d) (as well as In Progress or Participated) is a view of the form at the stage of when 
you completed your task.  Only the Return to Service Agent’s archive will show the completed form. 
 However, both the Initiator and Return to Service Agent will also receive an email confirmation of 
the receipt of the submitted form (with a read-only copy of the form). 

 

Q:  When I open the form, I do not see the Complete button. 

A:  Make sure that the zoom level at the bottom of the Internet Explorer window, right side of the 
Status Bar, is set to 100%. To see the Status Bar, go to View > Toolbars and select Status Bar. If 
setting the zoom level does not resolve the problem, contact the National Service Desk. 

 

 

 

http://eformservice.faa.gov/UserSupport.aspx
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5.7 Definitions 
AVS Provisioning Service (AVS-PS):  A web-based portal that allows end users to manage 
certain aspects of their account. AVS-PS allows end users to unlock their account, reset their 
password, and update their profile information. Additionally, AVS-PS allows FAA Points of Contact 
and authorized personnel the ability to create and manage accounts. 

 

Block:  A generic term used when referencing the Item area as identified in the Advisory Circular 
for the Form 337. Block is, therefore, synonymous with Item. 

 

Aircraft Certification Office (ACO):  The Aviation Safety Inspector coordinates with the ACO for 
the review and approval of supplemental or supporting documents included with Form 337 
submissions. 

 

Archive(d):  Forms that have been finalized and are now archived (read-only). 

 

Aviation Safety Inspector (ASI):  Federal Aviation Administration (FAA) full-time employee with 
the authority and credentials for oversight and surveillance of aviation specialties for operations, 
maintenance, or avionics. 

 

Certificate Authority:  The vendor who validates and verifies that the digital signature is a valid 
certificate and that the users signing with the certificate are who they say they are. 

 

Certification Authority:  An entity which issues Digital Certificates and performs certain functions 
associated with issuing such Digital Certificates. 

 

Compromise:  Reasonable suspicion or actual unauthorized disclosure, loss, loss of control over, 
or use of a Private Key associated with the Digital Certificate. 

 

Delegate:  A person who is authorized to initiate AVS accounts. A Delegate may or may not be an 
FAA employee. Unlike the POC, a Delegate can only create accounts for specific applications (i.e. 
Form 337). 

 

Designee (or DAR):  A Designated  Airworthiness Representative (DAR) who is authorized by the 
FAA to examine, test, and/or make inspections necessary to issue airman or aircraft certificates. 

 

Digital Certificate:  A signing certificate issued by a Certificate Authority for the purposes of 
digitally signing PDF documents. 

 

Digital Signature: A transformation of a message using an asymmetric cryptosystem such that a 
person having the initial message and the signer's Public Key can accurately determine whether the 
transformation was created using the Private Key that corresponds to the signer's Public Key and 
whether the message has been altered since the transformation was made. 
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Initiator/Modifier:  The individual who initiates and modifies the Form 337, major repair, or 
alteration to an aircraft. 

 

In Progress:  Forms that are in progress but not yet finalized. 

 

Installer:  Individual who completes the aircraft information in Blocks 1 and 2 of the e337 in the final 
processing of an e337 for a component repair. These individuals must have an account to access 
the system but may not have acquired a digital signature. 

 

Key Pair: Two mathematically related keys, having the following properties: (a) one key can be 
used to encrypt a message that can only be decrypted using the other key, and (b) even knowing 
one key, it is computationally infeasible to discover the other key.  

 

Organization: A legally recognized company, enterprise, or governmental agency that has applied 
for or has been issued Digital Certificates utilizing the TATI service. 
  

Point of Contact (POC):  An employee who is authorized to initiate account registrations. 

 

Private Key: The key of a Key Pair used to create a Digital Signature. This key must be kept 
private. 

 

Process ID:  Unique technical (system) ID number identifying each form upon execution of a 
workflow process. This is assigned the first time the Complete button is clicked when the form is 
opened in the user interface. 

 

Public Key: The key of a Key Pair used to verify a Digital Signature. The Public Key is made freely 
available to anyone who will receive digitally signed messages from the holder of the Key Pair. The 
Public Key is usually provided via a Digital Certificate issued by a Certification Authority. A Public 
Key is used to verify the digital signature of a message purportedly sent by the holder of the 
corresponding Private Key. 

 

Return to Service Agent (RTS):  Individual who is authorized to approve the work for return to 
service. 

 

Subscriber: A person or entity who (a) is the subject named or identified in the Digital Certificate 
issued to such person or entity, (b) holds a Private Key that corresponds to a Public Key listed in 
that Digital Certificate, and (c) the person or entity to whom digitally signed messages verified by 
reference to such Digital Certificate are to be attributed. 
 
Supplemental Document:  Files that provide supplemental information to the ASI in support of the 
modification but are not considered Attachments to the Form 337 and therefore are selected as 'Do 
Not Send To Registry'.  For example, proprietary information such as engineering report. 

 

Supporting Document:  Files that are essentially part of the Form 337 or an extension of Block 8 
and supports the description of the work to be accomplished.  At times a document may need an 
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approval signature (i.e., an Addendum to a Flight Manual Supplement).  This document is one that 
would be attached with the 'Send to Registry' selection and would, therefore, be delivered to 
Registry along with the Form 337. 

 

Task ID:  Incremental technical (system) ID number that helps track tasks at each individual stage 
of a form process to help troubleshoot system problems. 

 

Tracking Number:  The sequential form tracking number created for each Form 337 upon initial 
submission. 

 

Worklist:  A list of forms that were sent to you as part of an automated workflow. These are forms 
that need to be processed for approval, rejection, or for future editing. 
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